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Introduction

Important Notice

 The contents of this document and the specifications of this product are subject to change without notice.

 Unauthorized  duplication or reproduction of any or all content of this document is prohibited.

 Brother reserves the right to make changes without notice in the specifications and materials contained 
herein and shall not be responsible for any damages (including consequential) caused by reliance on the 
materials presented, including but not limited to typographical and other errors relating to the publications.

 Please note that we cannot assume any responsibility for any damage or lost profit arising from the use of 
the label created with this printer or the disappearance or change of data due to failure, repair or 
consumables using the rechargeable Li-ion battery, or any claim from a third party.

 For servicing, adjustments or repairs, contact Brother customer service or your local Brother dealer.

 If the printer operates abnormally or any dysfunction occurs, turn off the printer and disconnect each cord 
and contact Brother customer service or your local Brother dealer.

 Screen images in this document may differ depending on your version of Windows computer.

 Before using the printer, be sure to read all documents included with the printer for information about safety 
and correct operation.

 Not all models are available in all countries or regions.

Trademarks

 Android is a trademark of Google LLC.

 The Bluetooth® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any 
use of such marks by Brother Industries, Ltd. is under license.

 QR Code is a registered trademark of DENSO WAVE INCORPORATED.

 Epson ESC/P is a registered trademark of Seiko Epson Corporation.

 AirPrint, iPad, iPhone, and iPod touch are trademarks of Apple Inc.

 Wi-Fi® is a registered trademark of Wi-Fi Alliance®.

 Wi-Fi Protected Setup™ is a trademark of Wi-Fi Alliance®.
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License

 QR Code Generating Program Copyright © 2008 DENSO WAVE  INCORPORATED.

 BarStar Pro Encode Library (PDF417, Micro PDF417, DataMatrix, MaxiCode, AztecCode, GS1 
Composite, GS1 Databar, Code93, MSI/Plessey, POSTNET, Intelligent Mail Barcode) 

Copyright © 2007 AINIX Corporation. All rights reserved.

 Blue SDK

Copyright © 1995-2018 OpenSynergy GmbH.

All rights reserved. All unpublished rights reserved.

 Portions of this software are copyright © 2014 The FreeType Project 
(www.freetype.org). All rights reserved.

Available Manuals

You can download the latest manuals from the Brother support website at support.brother.com.

1 Printed manual in the box.
2 PDF manual on the Brother support website.

Product Safety Guide 1 2 This guide provides safety information; read it thoroughly before using your printer.

Quick Setup Guide 1 2 This guide provides basic information about using the printer along with safety 
information and detailed troubleshooting tips.

User’s Guide 2 This guide includes the contents of the Quick Setup Guide, and additional 
information about the printer settings, operations, safety precautions, 
communication settings, troubleshooting tips, and maintenance instructions.

Command Reference 2 This manual provides information about printer control commands for controlling 
the printer directly.

http://www.freetype.org
https://support.brother.com
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Symbols Used in This Guide

The following symbols are used throughout this guide:

Important Safety Instructions

DANGER
Failure to observe instructions and warnings will result in death or serious injuries. 
Follow these guidelines to avoid the risk of heat generation, smoking, explosion, or 
fire.

WARNING
Failure to observe instructions and warnings could result in death or serious injuries. 

Follow these guidelines to avoid the risk of heat generation, smoking,explosion, fire, 
or injury.

CAUTION
Failure to observe instructions and warnings could result in minor or moderate 
injuries.

Follow these guidelines to avoid injury.

Important Indicates information or directions that should be followed. Ignoring them may result 
in damage, or failed operations.

Note Indicates notes that provide information or directions that can help you better 
understand and use the product more efficiently.

DANGER
Rechargeable Li-ion Battery

 Do not allow the battery to come into contact with liquids.

 Do not charge, use, or leave the battery in high temperature (above 60°C /140°F) locations.

 Do not attempt to charge the battery using an unsupported charger.

 Use only for its intended purpose.

 Keep away from heat and fire.

 Do not connect the + and - terminals with metal objects such as wire. Do not carry or store the battery with metal 
objects.

 Do not throw, hit or damage the battery in any way.

 Do not solder any connections to the battery.

 Do not disassemble or modify the battery.

 Do not dispose of the battery with household waste.
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WARNING
DO NOT use the printer where its use is prohibited, such as on an airplane. This could affect the airplane’s equipment, 
resulting in an accident.

DO NOT use the printer in special environments, such as near medical equipment. Electromagnetic waves may cause 
the medical equipment to malfunction.

DO NOT allow organic solvents, such as benzene, thinner, nail polish remover, or deodorizers, to come into contact 
with the plastic cover. These may cause the plastic cover to warp or dissolve, resulting in an electrical shock or fire.

Printer, AC Adapter (Optional), or Car Adapter (Optional)

 When foreign objects are inserted into the printer or its connectors and ports, stop using the printer and turn off the 
power. Then disconnect each cable or remove the battery.

 Do not use, charge and store the products in any of the following places.

• Place where liquids come into contact.

• Place where there are much dust.

• Place whose temperature is extremely high.

• During a thunderstorm.

• Place where condensation forms.

 Do not disassemble or alter.

 Do not pour chemicals and combustible sprays over the products.

 Use and store the printer, other components, and packing bags out of the reach of children.

 Remove the battery or disconnect the cord when shipping.

 If the printer is not in use for long periods, remove the battery or disconnect the cord before storing.

Rechargeable Li-ion Battery

 Keep away from infants. If ingested, contact emergency services immediately.

 Stop using the battery if there are noticeable abnormalities such as smell, heat, deformities, or discoloration.

 If liquid from the battery gets into eyes, wash them immediately with clean water. Contact emergency services 
immediately.

AC Adapter, Car Adapter

 Use only with the specified product.

 Insert the plug firmly into the outlet.

 Use the AC adapter with household outlet (AC 100-240 V 50/60Hz) and Car adapter with DC 12 V.

 Do not allow metal objets to come into contact with connectors and ports.

 Do not pull on the cord when disconnecting the AC adapter cord or Car adapter from the electrical outlet. Hold the 
plug and pull it out of the electrical outlet.

 Do not damage, twist, severely bend, pull on, place objects on, bind the AC adapter and Car adapter.

 Do not allow the AC adapter and Car adapter to be pinched.

 Do not overload electrical outlets.
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CAUTION
RD Rolls use thermal paper, therefore the color of the label and the printing may change or fade if exposed to sunlight 
or heat. When using outdoors and when durability is important, we DO NOT recommend using RD Rolls.

Depending on the area, material, and environmental conditions, the label may unpeel or become permanently affixed, 
and the color of the label may change or be transferred to other objects. Before affixing the label, check the 
environmental conditions and the material. Test the label by affixing a small piece of it to an inconspicuous area of the 
intended surface.

Printer

 Do not hold the printer by the RD Roll compartment cover or the roll guide.

There is a risk that the cover could detach or the printer could fall.

 When connecting cables and accessories, follow the applicable instructions.

 Do not touch the print head and metal parts sorrounding the head.

 If the printer is used for a long periods of time, the parts of the printer shown may gethot enough to cause a low 
temperature burn.

 

Rechargeable Li-ion Battery

If liquid from the battery gets onto skin or clothes, immediately rinse with water.

AC Adapter, Car Adapter

Make sure you can always access the cord of the adapter so that you can disconnect it immediately in the event of an 
emergency.

Belt Clip

Make sure that the belt clip is attached securely to the printer and the wearer's belt.
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Warning Label

Do not touch the blade and print head.
 

IMPORTANT
 DO NOT remove the labels affixed to the printer. These labels provide operational information and indicate the 

printer's model number.

 DO NOT push the power button or LED indicator with an object that has a sharp point, such as a pen. This could 
damage the button or LED.

 DO NOT transport the printer while cables are connected to the DC connector or mini-USB port. The connector and 
ports could be damaged.

 DO NOT store the printer in an area exposed to high temperatures, high humidity, direct sunlight, or dust. These 
could cause discoloration or a malfunction.

CAUTION
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General Precautions
Printer

 If the Bluetooth and wireless LAN functions are both turned on, the communication speed may decrease due to 
radio wave interference. If this occurs, turn off the function you are not using (the Bluetooth or wireless LAN 
function).

 DO NOT cover or insert foreign objects into the paper exit slot, DC connector, or mini-USB port.

 DO NOT use paint thinner, benzene, alcohol or any other organic solvents to clean the printer. Doing so may cause 
damage to the surface finish. You can use isopropyl alcohol or ethanol only when cleaning the print head or roller. 
Use a soft, dry cloth to clean the printer.

 When not used for an extended period, remove the roll from the printer.

 Always keep the roll compartment cover closed when printing.

 This printer uses thermal paper. If the printed paper is marked with ink, for example written on or stamped, the ink 
may cause the printed text to fade or become discolored. In addition the applied ink may take some time to dry. 
Printed text may fade or become discolored if the label comes into contact with any of the following: vinyl chloride 
products, leather goods such as wallets and purses, organic compounds such as alcohol, ketones, or esters, 
adhesive tape, erasers, rubber mats, magic marker ink, permanent marker ink, correction fluid, carbon, glue, diazo 
sensitized paper, hand lotion, hair care products, cosmetics, water, or sweat.

 DO NOT touch the printer with wet hands.

 DO NOT use folded, wet or damp paper, otherwise a paper misfeed or malfunction may occur.

 DO NOT touch paper or labels with wet hands, otherwise a malfunction may occur.

RD Roll

 Use Brother accessories and supplies (indicated by the  mark)

 If the label is affixed to a wet, dirty, or oily surface, it may peel off easily. Before affixing the label, clean the surface 
to which the label will be affixed.

 RD Rolls use thermal paper, therefore ultraviolet rays, wind, and rain may cause the color of the label to fade and 
the ends of the label to peel off.

 DO NOT expose the RD Roll to direct sunlight, high temperatures, high humidity, or dust. Store in a cool, dark place. 
Use the RD Roll soon after opening the package.

 Scratching the printed surface of the label with your finger nails or metal objects, or touching the printed surface 
with hands dampened by water, sweat, or medicated cream etc., can cause the color to change or fade.

 DO NOT affix labels to people, animals, or plants. Never affix labels to public or private property without permission.

 The last labels of the RD Roll may not be printed correctly, therefore, each roll contains more labels than is indicated 
on the package.

 When a label is removed after being affixed to a surface, a portion of the label may remain.

 Once a label is affixed, it may be difficult to remove the label.

Printer, AC adapter, Car adapter, or Accessories

Observe all applicable regulations when disposing of these products.
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1
1

Parts Description 1

 

1 Upper tear bar

2 Lower tear bar

3 Roll compartment cover

4 Roll cover release lever

5 DC connector cover 

6 DC connector 

7 Interface cover

8 Mini-USB port

9 Near-Field Communication (NFC) sensor

10 Shoulder strap slots

11 Control panel

See Control Panel on page 14.

12 Docking station terminal cover

13 Battery cover (RJ-4250WB/RJ-4230B only)

14 Battery cover latch

15 Belt clip hook

16 Battery compartment

Set Up the Printer 1

1

2 3

4

5

6
7

89

11

10

15

13

14

16

12
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1
Control Panel 1

 

1 LED indicator

See LED Indicators on page 17.

2 LCD

See LCD on page 15.

3 (Feed) /OK button
To feed the paper or print the printer settings

4 Menu /  (Select) button

5  (Back) button

6 (Power) button
To turn the printer on/off

1

2

345

6
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1
LCD 1

When the printer is turned on, the main screen appears.
 

1 Update icon (RJ-4250WB only)
Indicates the FTP connectivity and update status.

: There is new data.

 (flashing): Data update failed.

 (flashing): Cannot connect to the server.

2 Menu key lock icon
Displayed when the [Menu Key Function] in Printer Setting Tool is set to [Disable].

3 Wireless Direct icon (RJ-4250WB only)

Indicates when Wireless Direct is available.

4 WLAN icon (RJ-4250WB only)

, , : The printer is connected to the network.

: The printer is searching for the network.

5 Bluetooth icon

Indicates Bluetooth is on. When the icon is flashing, auto re-pairing is in operation (see Auto re-pairing 
on page 65). 

6 Battery health level icon
When the printer is turned on, the battery health level displayed. It does not appear when charging is not 
possible.

Message Icon Condition

BatteryHealth Excellent No problems. The battery may be used.

BatteryHealth Good Still healthy. The battery can be used.

Battery Poor Replace soon Battery health is deteriorating.

Batt. Very Poor Replace 
battery 

The battery is badly deteriorated.

2

67

51 43

9

8
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1
7 Charge status icon

Displays the charge status of the battery.

 Charging (AC adapter connected): 

 Not Charging (Battery cannot charge when battery temperature is above 104°F (40°C) or below 32°F 

(0°C)): 

 Not Charging (Charging is finished or paused): No icon is displayed.

8 Battery level

Indicates the remaining battery level.

9 Printer status

 Full: 

 High: 

 Half: 

 Low:
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1
LED Indicators 1

The indicator lights and flashes to indicate the printer’s status. The symbols used in this section explain the 
meaning of the different indicator colors and patterns:

 or  or Indicator is lit in the color shown

 or  or Indicator is flashing in the color shown

Indicator is off

LED Indicator Status

Power off

Charging complete (when power is turned off)

No charging (when power is turned off)

Battery level: Half or more

Charging complete (when power is turned on)

Power on (when the battery is not connected but the AC adapter is connected)

No charging (when power is turned on)

Charging

Boot mode

Battery level: low

Sleep mode
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1

Note
If the indicator is lit in red (Boot mode), contact Brother Customer Service at 1-800-255-0415.

 

Roll end error

Feed error

Cover open error

Communication error

WPS connection error

BLF file error

No template error

Memory full error

ESC/P Memory full error

JPEG file error

Battery deterioration error

Mass storage error

Battery level: empty

System error

Database search error

Battery error (if the battery is not fully charged after the specified amount of time)

LED Indicator Status
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1
Button Functions 1

(Power) button function Operation

Turn on the printer While the printer is turned off, press the (Power) button.

Turn off the printer While the printer is turned on, press the (Power) button until the message 
[System Off] appears on the LCD. (If the [Auto Power Off] feature is enabled 
in the Device Settings, the printer will turn itself off automatically after the 
selected period of inactivity.)

Start the printer in mass storage 
mode

If you press and hold the (Power) button while also pressing the Menu/  
(Select) button, the printer starts in mass storage mode (see Mass Storage 
Mode on page 90).

(Back) button function Operation

Clear the selected menu item and 
return to the beginning.

Press the  (Back) button to return to the previous setting category.

Cancel the current print job. Press the  (Back) button to cancel the current print job.

Menu/
 (Select) button function

Operation

Enter the menu selection mode While the printer is turned on, press the Menu /  (Select) button.

Select the menu option When the menu is displayed, press the Menu /  (Select) button to select the 
next option.

Execute a file stored in the mass 
storage area

If you press this button while the printer is running in mass storage mode, you 
can execute a command file stored in the mass storage area (see Mass 
Storage Mode on page 90).

(Feed)/
OK button function

Operation

Feed the paper When the paper type is set to [Die-cut Label] or [Media With Marks]: 

Press the (Feed) /OK button to automatically feed the paper to the print 
position.

When the paper type is set to [Continuous Length Tape]: 

Press the (Feed) /OK  button to feed the paper.

Print the printer information Make sure that a roll is set, and then press and hold the (Feed) /OK  button. 
The printer starts printing its settings (see Print the Printer Information 
on page 89).

Activate the function mode for the 
selected item

Press the (Feed) / OK button to activate the selected menu option.
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1
Battery Installation/Removal 1

Important
Make sure you charge the rechargeable Li-ion battery (PA-BT-006) either in the printer, or in the charger 
before initial use.

 

Install the Battery 1

 For RJ-4250WB/RJ-4230B

a Unlock and pull out the battery cover.
 

b Insert the battery until it locks into place.
 

Note
• To remove the battery, reverse the installation procedure.

• Do not lose the battery cover as you will need to reattach it later.
 

 For RJ-4250WB-L/RJ-4230B-L

a Unlock and pull out the battery.
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1
b Remove the insulating sheet.

 

c Insert the battery until it locks into place.
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1
Recharge the Battery 1

While Installed in the Printer 1

To charge the rechargeable Li-ion battery (PA-BT-006), insert it into the printer and do the following:

Note
• Before using the battery, use the following procedure to charge it.

• Print speed varies with the available battery power.
 

a Make sure that the battery is installed in the printer.

b Use the compatible Brother AC adapter (PA-AD-600A) and the AC power cord to connect the printer to 
an AC power outlet (see How to Recharge the Battery with the AC Adapter (Optional) on page 23), or 
use the Brother compatible car adapter (PA-CD-600CG) to connect the printer to a DC power outlet (see 
How to Recharge the Battery with the Car Adapter (Optional) on page 24).

Note
• The LED indicator light is orange when the battery is charging.

When the battery is fully charged, the LED indicator turns off (when power is turned off) or lights in green 
(when power is turned on).

• Charging time is approximately 4 hours. It varies on the environmental conditions.

• Due to the temperature of the battery, charging may stop if the ambient temperature is outside the 
following range: 32°F to 104°F (0°C to 40°C).

• The recommended charging temperature range for the battery is from 41°F to 95°F (5°C to 35°C).
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1
How to Recharge the Battery with the AC Adapter (Optional) 1

Note

The AC adapter and AC power cord are optional accessories. When purchasing the printer, purchase the 
adapter and power cord appropriate for the region where the printer will be used.

By using the AC Adapter, you can use the printer even if the battery is not installed.
 

a Open the DC connector cover and connect the AC adapter to the printer.

b Connect the AC power cord to the AC adapter.

c Connect the AC power cord to a nearby AC power outlet (100 - 240 VAC, 50 - 60 Hz).
 

1 AC adapter

2 AC power cord

1

2
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1
How to Recharge the Battery with the Car Adapter (Optional) 1

Connect the printer to your vehicle’s 12 V DC power outlet (cigarette lighter or similar) to charge the 
rechargeable battery.

Note
The car adapter is an optional accessory.

The printer will function without a battery installed and external power applied.
 

a Connect the car adapter to the vehicle’s 12 V DC power outlet.

b Open the DC cover and connect the car adapter to the printer.
 

1 Car adapter

How to Recharge the Battery with the Battery Charger (Optional) or Active Docking Station 
(Optional) 1

The battery can be charged using the battery charger (Optional) or Active Docking Station (Optional). For 
more information, see Battery Charger (Optional:PA-BC-003) on page 145, or Active Docking Station 
(Optional:PA-CR-002) on page 154.

1
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1
Stop Battery Charging 1

To stop the battery charging, disconnect the AC adapter or car adapter from the DC connector.

Tips on Using the Battery 1

 High density (dark) printing discharges the battery faster than low density printing. You can adjust the print 
density setting in the Device Settings (see Device Settings on page 68).

 The battery charging must take place in an environment with a temperature between 32°F and 104°F (0°C 
and 40°C), otherwise the battery will not be charged. If the charging stops because the environment 
temperature is too low or too high, place the printer in an environment with a temperature between 32°F 
and 104°F (0°C and 40°C) and try charging again.

 The recommended charging temperature range for the battery is from 41°F to 95°F (5°C to 35°C).

 If you use the printer when both the battery is installed and the AC adapter or car adapter is connected, 
charging may stop even if the battery is not fully charged.

Battery Characteristics 1

To ensure the highest performance and longest life from the battery:

 Do not use or store the battery in a location exposed to extreme high or low temperatures as it may 
deteriorate more quickly.

 Remove the battery when storing the printer for long periods of time.

 Store batteries with less than a 50% charge in a cool dry place out of direct sunlight.

 Recharge the battery every six months if it is stored for long periods of time.

 It is normal and safe for the printer to become warm while charging. Disconnect the charger and stop using 
the printer if it becomes hot to the touch.

 When the printer is turned on, the battery health status is displayed on the LCD.

For battery health status displays, see LCD on page 15.

When not Using the Battery 1

The printer may be operated without the battery in the following ways:

 When an AC adapter (PA-AD-600A) or car adapter (PA-CD-600CG) is connected to the printer.

 When the printer is installed in the Active Docking Station (PA-CR-002).

Note
When the battery is not installed, securely fasten the battery cover with self-tapping screws (M2.6 x 0.24 
in. (6 mm)) (not included).
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1
Power On or Off 1

On: Press the (Power) button.

Off: Press the (Power) button until the message [System Off] appears on the LCD.

Note
• When the printer is connected to the AC adapter,  power turns on automatically by default.

• Do not remove the battery until the LCD turns off when the AC adapter is not connected to the printer and 
the AC power outlet.

 

Set the Language 1

a Press the Menu /  (Select) button to select the [Settings] menu, and then press the (Feed) / OK 
button.

b Select [  Language] , and then press the (Feed) / OK button. 

c Select a language, and then press the (Feed) / OK button.

Insert the Roll 1

a Push the roll cover release lever to open the roll compartment cover.
 

1 Roll cover release lever

1
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1
b Slide both roll guides outwards.

 

c Insert the roll.
 

1 Print surface (faces outwards on the roll)

d Close the roll compartment cover until it locks.
 

Important
For best performance, use genuine Brother RD rolls.

 

1
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Note

• When using die-cut labels, set the paper type to [Die-cut Label], and press the (Feed) / OK button after 
inserting the roll. The printer will feed the label to the top of form position.

• To remove the roll, reverse the installation procedure.

• Make sure inserted rolls turn correctly.
 

Use the Roll Holder Stop 1

The roll holder stop prevents the roll holder from closing.  It is ideal to minimize the distance needed to spread 
the roll holders in order to load the roll.

a Remove the backing paper from two locations on the roll holder stop.
 

b Extend the roll guide outward and attach the roll holder stop to the innermost part of groove.
 

Note
• Roll holder stop is supported for 4 inch roll.

• Attach the roll holder stop with the roll guide outwards.

• The roll holder stop can be attached to either side of the groove.

• Attach the roll holder stop not to enter surplus air between the adhesive layer and the printer. 

• Clean the pasted part of the printer before attaching.
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Tear Off Media 1

Receipt paper, labels, tags, and linerless media* can be torn off cleanly by swiftly pulling up or down on the 
media according to the set cutting position.

* Linerless media can only be torn upward.
 

1 Lower tear bar

2 Upper tear bar

CAUTION
 

Do not touch the blade.

 

Note
• The [Tear Bar] is set in the [Upward] position at the time of purchase. (When [Linerless] to [On] in the 

[Advanced] tab of the Printer Setting Tool, the [Tear Bar] cannot be selected.)

• To adjust the cutting position, open the Printer Setting Tool, and go to [Print Position / Sensor] in the 
[Device Settings], and then enter the setting you want in the [Tear Adjust] field. For more information, 
see Print Position / Sensor on page 76. 

 

1

2
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Attach the Belt Clip 1

You can carry the printer on your belt by attaching and using the included belt clip.  Follow the instructions 
below to attach the clip to the printer and to your belt. After attaching the clip to the printer, you can attach 
and secure it to your belt.

a Attach the belt clip to the belt clip hook on the printer, as shown:
 

1 Belt clip hook

b Attach the clip to your belt.
 

Important
• Make sure you attach the belt clip securely to the printer.

• To detach the belt clip, reverse the installation procedure.

• We recommend using a belt that is less than 0.2 in. (5 mm) thick and width is less than 1 7/8 in. (47.63mm).
 

1
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Install Software on Your Windows Computer or Mobile Device1

Several printing methods are available, depending on the printer model and the computer or mobile device 
you use to print from.

See the following tables and install other software on your computer or mobile device as needed.

Available Software 1

For computer 1

To use the printer with your computer, you must install the printer driver.

Software RJ-4250WB RJ-4230B Features

1 Printer driver —

2
Printer 
Setting 
Tool

Communication 
Settings Allows you to specify the printer’s communication 

settings and device settings from the computer.
Device Settings

P-touch 
Template 
Settings

Allows you to configure the P-touch template settings. 

P-touch Template provides functions for inserting data 
from a device (such as a barcode reader connected to 
the printer) into text and barcode objects in layouts 
saved on the printer, useful for printing templates and 
barcodes.

Paper Size 
Setup

Allow you to add the paper sizes not available in the 
[Paper Size] list of the printer driver.

3 P-touch Editor

Allows you to: 

 Store custom documents as template data.

 Use a large library of labels and tags by connecting 
to the database.

4
P-touch Transfer 
Manager

Allows you to transfer files created with P-touch Editor 
to a printer and store the files in the printer's memory. 
You can print them from the printer's memory without 
connecting to your computer.

5 P-touch Library
Allows you to manage and print P-touch Editor 
templates.

6 P-touch Transfer Express Allows you to transfer documents to the printer.

7 P-touch Update Software Allows you to update the firmware and software.

8 BRAdmin Professional —

BRAdmin Professional has more powerful features for 
managing network printers than BRAdmin Light. You 
can configure and check the status of your network 
connected printers, and transfer the template to the 
printer via a network.

✔ ✔

✔ ✔

✔ ✔

✔ ✔

✔ ✔

✔ ✔

✔ ✔

✔ ✔

✔ ✔

✔ ✔

✔
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For mobile devices 1

A software development kit (SDK) is also available.

To obtain the SDK and Font Manager, visit the Brother Developer Center (www.brother.co.jp/eng/dev/).

9 BRAdmin Light —
Allows you to configure the initial settings of network 
connected printers.

10 BRAgent —

Allows you to manage printers on different local 
networks* and send data to the computer on which 
BRAdmin Professional is installed.

* A local network is the area managed by a single 
router.

11 Web Based Management —
Allows you to use a standard web browser to manage 
a printer on your network using HTTP.

12 Font Manager

Allows you to transfer fonts to the printer and delete 
fonts from the printer.

Transferred fonts can be accessed and printed using 
various print commands.

 About font usage permission

When using fonts, you must abide by all terms and 
conditions set forth by each rightful font owner. 
Before downloading fonts, you must confirm that 
you have legitimate licences to use the fonts and 
comply with their terms and conditions; otherwise 
you may not download fonts.

Software RJ-4250WB RJ-4230B Features

1 Mobile Transfer Express

Allows you to use a mobile device to transfer files 
(templates, databases and images) which were 
prepared using P-touch Transfer Manager (Windows 
version), to a printer.

2
AirPrint 
(For Apple device)

—
Allows you to print from an Apple device (iPad, 
iPhone, or iPod touch) without installing additional 
software.

3 Web Based Management —
Allows you to use a standard web browser to manage 
a printer on your network using HTTP.

4
Print Service Plugin

(Android)

Allows you to print from an Android device without 
installing additional software.

5 Mobile Deploy

Allows you to perform updates for the settings and 
firmware of printers in the field using a mobile device. 
This software will send printer update files pre-
uploaded to DropBox or an Http(s) server to target 
printers.

Software RJ-4250WB RJ-4230B Features

✔

✔

✔

✔ ✔

✔ ✔

✔

✔

✔ ✔

✔ ✔

http://www.brother.co.jp/eng/dev/
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Install the Printer Driver and Software (When Using a Computer) 1

To print from your computer, install the printer driver, P-touch Editor and other software on your computer.

Visit our website (install.brother) and download the installer for the software and manuals.

When a serial number is requested, see the base of the printer and enter the number.

http://install.brother/
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Connect the Printer to a Computer or Mobile Device 1

Refer to the directions for the type or connection method:

 USB cable connection (computer only)

See Connect Using USB (Computer Only) on page 34.

 Bluetooth connection

See Connect Using Bluetooth on page 35.

 Wireless LAN connection (RJ-4250WB only)

See Connect Using Wi-Fi (RJ-4250WB Only) on page 36.

 NFC connection (Android)

See Connect Using NFC (Android) on page 40.

Connect Using USB (Computer Only) 1

a Before connecting the USB cable, make sure that the printer is turned off.

b Connect the printer end of the USB cable to the mini-USB port on the side of the printer.

c Connect the other end of the USB cable to the USB port on the computer.

d Turn on the printer.
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Connect Using Bluetooth 1

Note

Follow the manufacturer's recommendations for your Bluetooth-equipped devices (computers and mobile 
devices) or Bluetooth adapter, and install any necessary hardware and software.

 

Use this procedure to pair the printer with the computer using the Bluetooth management software.

a Press the Menu/  (Select) button to select the [Bluetooth] menu, and then press the  (Feed) / OK 
button.

b Select [On/Off] and then press the  (Feed) / OK button.
Select [On].

c Use your Bluetooth management software to discover the printer.
Select the printer where XXXX is the last four digits of the printer's serial number. You can find the serial 
number label on the base of the printer.
Bluetooth communication is now available.

Note
• You can also change the printer’s communication settings using the Communication Settings (see 

Communication Settings on page 49).

• By default, Bluetooth mode is set to [Classic & LE], so two identical Bluetooth names (for Classic and 
Low Energy) might be displayed in the Bluetooth menu of your Android device.

 



Set Up the Printer 

36

1
Connect Using Wi-Fi (RJ-4250WB Only) 1

The following Wi-Fi connection methods are available:

 Wireless Direct

 Infrastructure Mode

 Infrastructure Mode + Wireless Direct

 WPS (Wi-Fi Protected Setup™)

Wireless Direct 1

Wireless Direct allows you to connect the printer to your computer or mobile device directly without a Wi-Fi 
access point/router; the printer serves as a Wi-Fi access point.

a Confirm the Wireless Direct settings of the printer.

 Using the printer

1 On the printer, press the Menu/  (Select) button to select the [WLAN] menu, and then press the 
(Feed) / OK button.

2 Press the Menu/  (Select) button to select the [Mode] menu, and then press the (Feed) / OK 
button.

3 Select [Direct], and then press the (Feed) / OK button. The Wireless Direct icon appears on 
the LCD.

 Using a computer

Connect the printer and computer with a USB cable. Start the Printer Setting Tool on your computer, 
and click the [Communication Settings] button. Confirm that [Wireless Direct] is selected for 
[Selected Interface] in the [General] tab.

See Communication Settings on page 49 for more information on the Communication Settings.

b On the printer, press the Menu/  (Select) button to select the [WLAN] menu, and then press the 
(Feed) / OK button.

Set [On/Off] to [On].

c Use your computer or mobile device to select the SSID of the printer ("DIRECT-*****_RJ-4250WB"). If 
required, enter the password ("425*****"). ***** is the last five digits of the serial number.

Note

• You can change the printer’s network settings using the Printer Setting Tool (see Change the Printer 
Settings on page 46).

• The Printer Setting Tool also allows you to apply the network settings changes to multiple printers. (See 
Apply Setting Changes to Multiple Printers on page 67.)

• You can find the serial number label on the base of the printer.

You can also confirm the serial number by printing the printer information (see Print the Printer Information 
on page 89).
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• You cannot connect to the Internet via Wi-Fi while using Wireless Direct. To use the Internet, connect using 

Infrastructure Mode.
 

Infrastructure Mode 1

Infrastructure Mode allows you to connect the printer to a computer or mobile device via a Wi-Fi access 
point/router.

 Before You Begin

First you must configure the Wi-Fi settings of the printer to communicate with your Wi-Fi access 
point/router. After the printer is configured, computer or mobile devices on your network will have access 
to the printer.

Important
• If you are going to connect the printer to your network, we recommend that you contact your system 

administrator prior to installation. You must confirm your Wi-Fi settings before you proceed with this 
installation.

• To configure the Wi-Fi settings again, or if the status of the printer's Wi-Fi connection is unknown, reset 
the Wi-Fi settings of the printer.

1 Press the (Power) button to turn off the printer.

2 Press and hold the (Feed) / OK button and the (Power) button for about five seconds. The LED 
indicator starts blinking in green.

3 While pressing the (Power) button, press the (Feed) / OK button twice.

4 Release the (Power) button.
 

Note

To achieve the best results with normal everyday document printing, use the printer as close to the Wi-Fi 
access point/router as possible with minimal obstructions. Large objects and walls between the two 
devices as well as interference from other electronic devices can affect the data transfer speed of your 
documents.
 

 Connect the printer to your Wi-Fi access point/router

a First, write down the SSID (network name) and password (network key) of your Wi-Fi access 
point/router.

b Connect the printer and computer with a USB cable.

c On the printer, press the Menu/  (Select) button to select the [WLAN] menu, and then press the 
(Feed) / OK button.

Set [On/Off] to [On].
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d Configure the Infrastructure Mode settings of the printer.

 Using the printer

1 On the printer, press the Menu/  (Select) button to select the [WLAN] menu, and then press the 
 (Feed) / OK button.

2 Press the Menu/  (Select) button to select the [Mode] menu, and then press the (Feed) / 
OK button.

3 Select [Infrastructure], and then press the (Feed) / OK button.

 Using a computer

Start the Printer Setting Tool on your computer, and click the [Communication Settings] button. 
Select [Wireless LAN] for [Selected Interface] in the [General] tab, and select [Infrastructure] 
for [Communication Mode] in [Wireless Settings] in the [Wireless LAN] tab.

See Communication Settings on page 49 for more information on the Communication Settings.

e Start the Printer Setting Tool on your computer, and click the [Communication Settings] button. 
Select [Wireless Settings] in the [Wireless LAN] tab.
Enter the SSID that you wrote down, or click [Search] and select the SSID from the displayed list.

f Enter the password as [Passphrase].

Note
The required information depends on the authentication method and encryption mode; enter only the 
information relevant to your network environment.

 

g Click [Apply].
When the connection between the printer and your Wi-Fi access point/router is established, the 

(Wi-Fi) icon appears on the printer's LCD. Computers and mobile devices that are on the same 
network as the printer will have access to the printer.

Note

• To change any other network settings, use the Printer Setting Tool (see Change the Printer Settings 
on page 46).

• To connect your mobile device to the Wi-Fi access point/router, select the SSID and enter the password 
of the Wi-Fi access point/router to establish the connection between the mobile device and Wi-Fi access 
point/router.

 

Infrastructure Mode + Wireless Direct 1

Infrastructure Mode and Wireless Direct can be used at the same time.

 Use the printer

a On the printer, press the Menu/  (Select) button to select the [WLAN] menu, and then press the 
(Feed) / OK button.

b Press the Menu/  (Select) button to select the [Mode] menu, and then press the (Feed) / OK 
button.
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1
c Select [Direct/Infra], and then press the (Feed) / OK button.

 Using a computer

a Start the Printer Setting Tool on your computer, and click the [Communication Settings] button.

b Select [Infrastructure and WirelessDirect] for [Selected Interface] in the [General] tab.
See Communication Settings on page 49 for more information on the Communication Settings.

WPS (Wi-Fi Protected Setup™) 1

If your Wi-Fi access point/router supports WPS, settings and connections can be configured quickly.

a First, confirm that your Wi-Fi access point/router has the WPS symbol.
 

b Place the printer within the range of your Wi-Fi access point/router. The range may differ depending on 
your environment. See the instructions provided with your Wi-Fi access point/router.

c Press the WPS button on your Wi-Fi access point/router.

d On the printer, press the Menu/  (Select) button to select the [WLAN] menu, and then press the 
(Feed) / OK button.

e Press the Menu/  (Select) button to select the [WPS] menu, and then press the (Feed) / OK button.

f Select [Button Push] or [PIN Code], and then press the (Feed) / OK button.

For details, see the instructions provided with your Wi-Fi access point/router.

When the connection is established, the WLAN icon appears on the printer's LCD. Computers and mobile 
devices that are on the same network as the printer will have access to the printer.

Note
• The printer will try to connect using WPS for two minutes. If the Menu/  (Select) button is pressed during 

that time, the printer will continue trying to connect for an additional two minutes.

• If your computer or mobile device supports the PIN authentication method, select [PIN Code] for better 
security.

 

How to confirm your printer's IP address 1

a On the printer, press the Menu/  (Select) button to select the [WLAN] menu, and then press the 
(Feed) / OK button.

b Press the Menu/ (Select) button to select the [IP Address] menu, and then press the (Feed) / OK 
button.
The LCD displays the IP address and SSID (Network Name) for Wireless Direct or Infrastructure Mode.
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Connect Using NFC (Android) 1

Confirm that the printer's Bluetooth settings and the mobile device's Bluetooth and NFC settings are all set 
to ON, and touch your mobile device to the printer.
 

Note
• The printer's Bluetooth mode must be set to [Classic & LE] or [Classic]. [Low Energy] is not 

supported.

• NFC compatibility with your Android device cannot be guaranteed.
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LCD 1

LCD Settings 1

Specify Settings from the Computer 1

You can specify the LCD settings either by using the printer, or by using the Printer Setting Tool on a 
computer connected to the printer. For more information about connecting a computer and specifying 
settings, see Change the Printer Settings on page 46.

Specify Settings from the Printer 1

Press the Menu/  (Select) button to select a menu option, and then press the (Feed) / OK button. Press 
the Menu/  (Select) button to select an option, and then press the (Feed) / OK button.
 

1 The currently selected option is highlighted.

2 The scroll bar indicates the first parameter with the up arrow, and the last parameter with the down arrow. 
If the last parameter is selected, pressing  (Select) button scrolls back to the first parameter.

 Set the Media Size

a Press the Menu/  (Select) button to select the [Media] menu, and then press the OK button.

b Select [Select Media], and then press the OK button.

 Detect the Media Size

The die-cut media can be detected automatically.

a Set the die-cut media in the printer.

b Press the Menu/  (Select) button to select the [Media] menu, and then press the (Feed) / OK 
button.

c Select [Auto Detect], and then press the (Feed) / OK button. 

Note
If the media size cannot be detected, set the media size from [Select Media].
 

21
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 Set the LCD Contrast

a Press the Menu/  (Select) button to select the [Settings] menu, and then press the (Feed) / 
OK button.

b Select [LCD Contrast] , and then press the (Feed) / OK button. Select the option, and then press 
the (Feed) / OK button.

 Set the Beeper

Select whether the printer beeps at startup, shutdown and error.

a Press the Menu/  (Select) button to select the [Settings] menu, and then press the (Feed) / 
OK button.

b Select [Beeper] , and then press the (Feed) / OK button. Select the option, and then press the 
(Feed) / OK button.

 Bluetooth Functions

[On/Off]: To connect the printer and your Bluetooth-equipped devices, see Connect Using Bluetooth 
on page 35.

[Mode]: Bluetooth mode can be selected from [Classic & LE], [Classic], or [Low Energy].

[AutoReconnect]: Automatically reconnects to a previously connected to iOS supported devices 
including iPhone, iPad and iPod touch.

[Clear History]: Deletes information for auto re-paired devices registered in the printer.

[BT Address]: The Bluetooth address of the printer appears on the display.

[Print Barcode]: The Bluetooth address and corresponding barcode (width:1.65 in./42 mm) can be 
printed.

Note
When printing large print jobs, set the Bluetooth mode to [Classic].

 

 Wi-Fi Options (RJ-4250WB only)

For connection methods and settings using the Wi-Fi function, see Connect Using Wi-Fi (RJ-4250WB 
Only) on page 36.

[On/Off]: Connect your printer to a wireless device.

[Mode]: Select a wireless connection mode.

Available settings: [Direct], [Infrastructure], [Direct/Infra]

[WPS]: Set up a WPS connection.

[WLANAssistant]: This function might be needed while installing the driver.

[IP Address]: View the printer's IP address and SSID (Network Name).
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 Remote Update (RJ-4250WB only)

Connect to the FTP server and download new templates, databases, and other files. Set the information 
of the FTP server in advance using [Communication Settings] in the Printer Setting Tool. For more 
information, see Communication Settings on page 49.

This item appears when the FTP server is set and updated files are available.

a Press the Menu/  (Select) button to select the [Update] menu, and then press the (Feed) / OK 
button.

b Select [Start] , and then press the (Feed) / OK button.
When the update starts, [Receiving] or [Downloading] appears on the LCD.
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2
Print from Windows Computer 2

Printing with the Printer Driver 2

a Open the document you want to print.

b Connect the printer to a computer using USB, Bluetooth or Wi-Fi (see Connect the Printer to a Computer 
or Mobile Device on page 34).

Note

If necessary, change the printer settings in the printer driver’s dialog box, or in the Printer Setting Tool (see 
Change the Printer Settings on page 46).

 

c Print from the software.
The message [Printing] appears on the LCD. When printing is finished, the printer reverts to the mode 
selected before printing started.

Note

To print a JPEG image without using the printer driver, see Print JPEG Images on page 91.
 

Make Prints Lighter or Darker 2

You can make prints lighter or darker by adjusting the print density setting in the Device Settings (see Device 
Settings on page 68).

When using the battery, changing the print density setting may result in slight changes in printing speed and 
the number of pages that can be printed on a single charge.

Set Printer Driver Options 2

You can configure various settings such as paper size and number of copies, in the printer driver screen.

Note
You can also use the Printer Setting Tool (see Change the Printer Settings on page 46) to configure 
advanced settings.

 

How to Use the Printer 2
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2

Custom Printing from Mobile Devices 2

A software development kit (SDK) is available.

Visit the Brother Developer Center (www.brother.co.jp/eng/dev/).

You can print from your mobile device using AirPrint (RJ-4250WB only).

For more information, see the AirPrint Guide. Visit your model's Manuals page on the Brother support website 
at support.brother.com to download the guide.

http://www.brother.co.jp/eng/dev/
https://support.brother.com
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3

Printer Setting Tool 3

Using the Printer Setting Tool, you can specify the printer’s communication settings, operation settings, 
P-touch template settings and paper size settings from Windows computer.

Note
The Printer Setting Tool is installed automatically when you use the installer to install the printer driver. For 
more information, see Install Software on Your Windows Computer or Mobile Device on page 31.

 

Important
The Printer Setting Tool is available only with compatible printers.

 

Before Using the Printer Setting Tool 3

 Make sure that the printer is connected to an electrical outlet and turned on.

 Make sure the printer driver has been installed correctly and you can print.

 Connect this printer to a computer with a USB cable. This tool cannot be used to configure printers 
connected to a wireless network.

Change the Printer Settings 3
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Use the Printer Setting Tool 3

a Connect the printer you want to configure to the computer.

b Start the Printer Setting Tool.

 For Windows 10 / Windows Server 2016 (RJ-4250WB):

Click [Start] > [Brother] > [Printer Setting Tool].

The main window appears.

 For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2 
(RJ-4250WB):

Click the [Printer Setting Tool] icon on the [Apps] screen.

 For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB):

Click [Start] > [All Programs] > [Brother] > [Label & Mobile Printer] > [Printer Setting Tool].
 

1 Printer

Lists the connected printers.

2 Communication Settings

Specifies the wireless LAN (RJ-4250WB only) and Bluetooth communication settings.

3 Device Settings
Specifies printer operation settings, such as power settings and printer settings. Settings can also 
be specified for the LCD.

4 P-touch Template Settings

Specifies P-touch template settings.
For more information on P-touch Template, download the P-touch Template Manual/Command 
Reference (English only) from the Brother support website at support.brother.com.

3

2

4

5

6

1

https://support.brother.com


Change the Printer Settings 

48

3

5 Paper Size Setup
Add media information and settings to the printer driver to use sizes not listed in the [Paper Size] 
list of the printer driver.

Important
To open [Paper Size Setup], you must be logged on with administrator rights.

 

6 Exit

Closes the window.

c Check that the printer you want to configure appears next to [Printer]. If a different printer appears, select 
the printer you want from the drop-down list.

d Select the setting you want to change, and then specify or change the settings in the dialog box.
For more information on the settings dialog boxes, see Communication Settings on page 49, Device 
Settings on page 68, P-touch Template Settings on page 80, or Paper Size Setup on page 83.

e Click [Apply] - [Exit] in the settings dialog box to apply the settings to the printer.

f Click [Exit] in the main window to finish specifying settings.

Important
Use the Printer Setting Tool to configure the printer only when the printer is in standby. The printer may 
malfunction if you try to configure it while it is handling a job.
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Communication Settings 3

With [Communication Settings] in the Printer Setting Tool, the printer communication information can be 
specified or changed when connecting the printer and computer with a USB cable or via a Bluetooth 
connection. Not only can you change the communication settings for one printer, but you can also apply the 
same settings to multiple printers.

Settings Dialog Box 3

 

1 Disable these settings

When this check box is selected,  appears in the tab, and the settings can no longer be specified or 

changed.

Settings in a tab where  appears will not be applied to the printer even if [Apply] is clicked. In addition, 

the settings in the tab will not be saved or exported when the [Save in Command File] or [Export] 
command is executed.

To apply the settings to the printer or save or export them, make sure you clear the check box.

2 Items

When [Current Status] is selected, the current settings appear in the settings display/change area.
Select the item for the settings that you want to change.

3 Menu Bar

4 Printer

Lists the connected printers.

7

8

5

6

9 10

3

4

1

2
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5 Node Name/Bluetooth device name
Displays the node name (nodes can be renamed) and Bluetooth device name. (See 7 Change Node 
Name/Bluetooth Device Name in Menu Bar on page 51.)

6 Settings Tabs

Contains settings that may be specified or changed.

If  appears in the tab, the settings in that tab will not be applied to the printer.

7 Settings Display/Change Area
Displays the current settings for the selected item.

8 Refresh
Updates the displayed settings with the most recent information.

9 Apply

Applies the settings to the printer.
To save the specified settings in a command file, select [Save in Command File] from the drop-down list. 
The saved command file can be used with the mass storage mode to apply the settings to a printer. (See 
Mass Storage Mode on page 90.)

Important
Clicking [Apply] applies all settings in all tabs to the printer.

If the [Disable these settings] check box is selected, the settings in that tab are not applied.
 

10 Exit
Exits [Communication Settings], and returns to the main window of the Printer Setting Tool.

Important
Changes to settings are not applied to printers if you click [Exit] without first clicking the [Apply] button.
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Menu Bar 3

 

1 Apply Settings to the Printer
Applies the settings to the printer.

2 Save Settings in Command File

Saves the specified settings in a command file. The file extension is .bin.
The saved command file can be used with the mass storage mode to apply the settings to a printer. (See 
Mass Storage Mode on page 90.)

Note
If the [Disable these settings] check box is selected, the settings in that tab are not saved.
 

Important
• The following information is not saved with the command file:

• Node name

• IP address, subnet mask and default gateway (when the IP address is set to [STATIC])
• The saved communication settings commands are intended to be used only for applying settings to a 

printer. To apply the settings to the printer using this command file, use the mass storage mode.

• Saved command files contain authentication keys and passwords. We recommend storing command files 
only if necessary.

• Do not send the command file to a different printer model.
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3 Install Certificates (RJ-4250WB only)
Some network authentication methods may require a certificate.

Install a certificate on the connected printer or save a certificate as a command file that can be distributed 
to the same model printers.

4 Import
 Import from the current computer wireless settings

Imports the settings from the computer.

Note
• When importing the wireless settings, administrator privileges for the computer are required.

• Only personal security authentication settings (open system, public key authentication and 
WPA/WPA2-PSK) can be imported. Enterprise security authentication (such as EAP-FAST), WPA2-PSK 
(TKIP) and WPA-PSK (AES) settings cannot be imported.

• If multiple wireless networks are enabled on the computer, only the personal settings that are detected first 
will be imported.

• Only the settings from the [Wireless LAN] tab - [Wireless Settings] pane can be imported 
(communication mode, SSID, authentication method, encryption mode and authentication key).

 

 Select a Profile to import
Imports the exported file and applies the settings to a printer.

Click [Browse] and select the file you want to import. The settings in the selected file appear in the 
settings display/change area.

Note
• All settings (such as wireless settings or TCP/IP settings) can be imported, except for node names.

• Only the profiles compatible with the selected printer can be imported.
• If the imported profile’s IP address is set to [STATIC], change the IP address of the imported profile, if 

needed, so that it does not duplicate the IP address of an existing printer on the network.
 

5 Export
Saves the current settings in a file.

Note

If the [Disable these settings] check box is selected, the settings in that tab are not saved.
 

Important
Exported files are not encrypted.
 

6 Automatically restart the printer after applying new settings

If this check box is selected, the printer automatically restarts after communication settings are applied.
If this check box is cleared, your must restart the printer manually.
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Note
When configuring multiple printers, you can reduce the time needed to change settings by clearing this 
check box. In this case, we recommend selecting this check box when configuring the first printer so that 
you can confirm that each setting is operating as intended.
 

7 Automatically detects the connected printer, and retrieves the current settings
If this check box is selected and a printer is connected to the computer, the printer is automatically 
detected and the printer’s current settings are displayed in the [Current Status] pane.

Note
If the model of the connected printer is different from that of the printer shown in the [Printer] drop-down 
list, the settings available on all tabs change to match the connected printer.
 

8 Change Node Name/Bluetooth Device Name

Allows renaming a node and Bluetooth device.

9 Reset to Default Communication Settings

Returns the communication settings to their factory settings.

10 Display Help
Displays the Help.

11 About

Displays the version information.
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General Tab 3

Communication Settings 3

 

1 Network Settings on Power On (RJ-4250WB only)
Specifies the conditions for connecting via Wi-Fi when the printer is turned on.

Available settings: [On by default], [Off by default], [Keep Current State]

2 Selected Interface (RJ-4250WB only)
Available settings: [Infrastructure], [Infrastructure and Wireless Direct], [Wireless Direct]

3 Bluetooth on Power On
Specifies the conditions for connecting via Bluetooth when the printer is turned on.

Available settings: [On by default], [Off by default], [Keep Current State]

1
2
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IPv6 (RJ-4250WB only) 3

 

1 IPv6 usage
Available settings: [Enable], [Disable]

2 Priority on IPv6 address

Select to give priority to an IPv6 address.

1
2
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Remote Update (RJ-4250WB only) 3

 

1 IP Address of FTP server

Type the FTP server address.

2 Port
Specifies the port number used to access the FTP server

3 User name
Type a user name that has permission to log in to the FTP server. 

4 Password

Type the password associated with the user name you entered in the Username field.

5 Path
Type the path to the folder on the FTP server where you want to download the update file from.

6 Setting file name
Specifies the update file name on the FTP server.

1
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 Log
 

1 Log storage
Select whether to export the update log to the FTP server.

Available settings: [Enable], [Disable]

2 Log storage path of FTP server
Type the path to the folder on the FTP server where you want to export the log data.

1
2
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Wireless LAN Tab (RJ-4250WB Only) 3

TCP/IP (Wireless) 3

 

1 Boot Method

Available settings: [AUTO], [BOOTP], [DHCP], [RARP], [STATIC]

2 IP Address/Subnet Mask/Gateway
You can type these settings only when the IP address is set to [STATIC].

3 DNS Server Method
Available settings: [AUTO], [STATIC]

4 Primary DNS Server IP Address/Secondary DNS Server IP Address

You can type these settings only when the DNS server is set to [STATIC].

1
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IPv6 3

 

1 Static IPv6 Address
Specifies a permanent IPv6 address.

2 Enable this address

Enables the specified static IPv6 address.

3 Primary DNS Server IPv6 Address/Secondary DNS Server IPv6 Address

Specifies the DNS server IPv6 addresses.

4 IPv6 Address List
Displays the list of IPv6 addresses.

1
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Wireless Settings 3

 

1 Communication Mode
The [Infrastructure] mode setting is available only for RJ-4250WB.

2 SSID (Network Name)

Clicking [Search] displays the available SSID selections in a separate dialog box.

3 Channel
This setting is selected automatically for RJ-4250WB.

4 Authentication Method/Encryption Mode 
The supported encryption modes for the authentication methods are as shown in Authentication Methods 
and Encryption Modes on page 61. 

5 WEP Key

You can specify a setting only when WEP is selected as the encryption mode. 

6 Passphrase
You can specify a setting only when WPA/WPA2-PSK is selected as the authentication method.

7 User ID/Password 

You can specify settings only when EAP-FAST, PEAP, EAP-TTLS or EAP-TLS is selected as the 
authentication method. In addition, with EAP-TLS, it is not necessary to register a password, but a client 
certificate must be registered. To register a certificate, connect to the printer from a web browser, and then 
specify the certificate. For more information, see Web Based Management on page 137 or Install 
Certificates (RJ-4250WB only) on page 52.

8 Display the key and password on-screen

If this check box is selected, keys and passwords are displayed in plain (non-encrypted) text.

1
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Authentication Methods and Encryption Modes 3

Important
To specify higher level security settings:

When performing certificate verification with EAP-FAST, PEAP, EAP-TTLS or EAP-TLS authentication 
methods, the certificate cannot be specified from the Printer Setting Tool. After the printer is configured to 
connect to the network, specify the certificate by accessing the printer from a web browser.

For more information, see Web Based Management on page 137 or Install Certificates (RJ-4250WB only) 
on page 52.

 

Authentication Method Encryption Mode

Open System None / WEP

Shared Key WEP

WPA/WPA2-PSK TKIP+AES / AES

EAP-FAST/NONE TKIP+AES / AES

EAP-FAST/MS-CHAPv2 TKIP+AES / AES

EAP-FAST/GTC TKIP+AES / AES

PEAP/MS-CHAPv2 TKIP+AES / AES

PEAP/GTC TKIP+AES / AES

EAP-TTLS/CHAP TKIP+AES / AES

EAP-TTLS/MS-CHAP TKIP+AES / AES

EAP-TTLS/MS-CHAPv2 TKIP+AES / AES

EAP-TTLS/PAP TKIP+AES / AES

EAP-TLS TKIP+AES / AES
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Wireless Direct Tab (RJ-4250WB Only) 3

Wireless Direct Settings 3

 

1 SSID/Network Key Generation
Available settings: [AUTO], [STATIC]

2 SSID (Network Name)/Network Key

Specifies the SSID (25 ASCII characters or fewer) and the network key (63 characters or fewer) you want 
to use in the Wireless Direct mode.
You can only specify a setting when  [STATIC] is selected for [SSID/Network Key Generation].

Note
The factory default SSID is "DIRECT-*****_RJ-4250WB" and password is "425*****".

***** is the last five digits of the serial number.
(You can find the serial number label on the base of the printer.)
 

3 Channel

Specifies the channel to use in the Wireless Direct mode.

1
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Bluetooth Tab 3

Bluetooth Settings 3

 

1 Bluetooth Mode

Set the control mode when Bluetooth is enabled.
Available settings: [Classic & Low Energy], [Classic Only], [Low Energy Only]

1
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 Classic
 

1 Visible to Other Devices
Allows the printer to be “discovered” by other Bluetooth devices.

Available settings: [Discoverable], [Not Discoverable]

2 Change PIN code

If this check box is selected, you can change the PIN code.

3 Display the PIN code on-screen
If this check box is selected, your computer displays the PIN by default.

4 Request Secure Simple Pairing (SSP) settings during pairing

If this check box is selected when using Classic Bluetooth Mode, it is necessary to perform additional 
printer key operations to press  (Feed) / OK button in the printer (authentication process) when 
pairing with devices running Bluetooth Version 2.1 or later.
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• Auto re-pairing
 

1 Auto re-pairing
Sets whether or not to automatically reconnect to a previously connected iOS device.

Available settings: [Enable], [Disable]

2 Delete Auto Re-paired Device

Pressing this button deletes information for auto re-paired devices registered in the printer.

1
2



Change the Printer Settings 

66

3

 Low Energy
 

1 Minimum Security Mode

Select the minimum security level when using [Low Energy Only] mode.
Available settings: [None], [Unauthenticated Encryption], [Authenticated Encryption], [LE Secure 
Connections]

2 Request Secure Simple Pairing (SSP) settings during pairing

If this check box is selected when using [Low Energy Only] mode, additional Printer key operations to 
press  (Feed) / OK button in the printer (authentication process) are required when pairing with Low 
Energy compatible devices.

1
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Apply Setting Changes to Multiple Printers 3

a After applying the settings to the first printer, disconnect the printer from the computer, and then connect 
the second printer to the computer.

b Select the newly connected printer from the [Printer] drop-down list.

Note

If the [Automatically detects the connected printer, and retrieves the current settings] check box in 
the [Option Settings] dialog box is selected, the printer connected with the USB cable is automatically 
selected.

For more information, see Communication Settings on page 49.
 

c Click [Apply].
The same settings that were applied to the first printer are applied to the second printer.

Note

We recommend selecting the [Automatically restart the printer after applying new settings] check box 
when configuring the first printer so that you can confirm that a connection with the Wi-Fi access 
point/router can be correctly established with the settings. For more information, see Communication 
Settings on page 49.

 

d Repeat steps a – c for all printers whose settings you want to change.

Important
If the first printer's IP address is set to [STATIC], the other printers will also use the same address. If 
needed, you can change each printer's IP address in the [Wireless LAN] tab.

 

Note

To save the current settings in a file, click [File] - [Export].

The same settings can be applied to another printer by clicking [File] - [Import], then selecting the 
exported settings file. (See Communication Settings on page 49.)
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Device Settings 3

With [Device Settings] in the Printer Setting Tool, printer settings can be specified or changed when 
connecting the printer and computer with a USB cable or via a Bluetooth connection. Not only can you change 
the device settings for one printer, but you can also apply the same settings to multiple printers.

When printing from a computer applications, various print settings can be specified from the printer driver; 
however, by using [Device Settings] in the Printer Setting Tool, more advanced settings can be specified.

When [Device Settings] is opened, the printer’s current settings are retrieved and displayed. If the current 
settings could not be retrieved, the previous settings are displayed. If the current settings could not be 
retrieved and previous settings have not been specified, this tool’s default settings are displayed.

Settings Dialog Box 3

 

1 Menu Bar
Select a command contained in each menu from the list.

2 Printer

Specifies the printer whose device settings are to be configured.
If only one printer is connected, it is unnecessary to make a selection because only that printer will appear.

3 Settings Tabs

Contains settings that may be specified or changed.
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Note

If  appears in the tab, the settings in that tab cannot be specified or changed. In addition, the settings 

in the tab will not be applied to the printer even if [Apply] is clicked. The settings in the tab will also not be 
saved or exported when the [Save in Command File] or [Export] command is executed.
 

4 Disable these settings

When this check box is selected,  appears in the tab, and the settings can no longer be specified or 

changed.

Settings in a tab where  appears will not be applied to the printer even if [Apply] is clicked. In addition, 

the settings in the tab will not be saved or exported when the [Save in Command File] or [Export] 
command is executed.

5 Current Settings

Retrieves the settings from the currently connected printer and displays them in the dialog box. Settings 

will also be retrieved for parameters on tabs with .

6 Parameters
Displays the current settings.

7 Exit

Exits [Device Settings], and returns to the main window of the Printer Setting Tool.

8 Apply
Applies the settings to the printer.

To save the specified settings in a command file, select [Save in Command File] from the drop-down list.
The saved command file can be used with the mass storage mode to apply the settings to a printer. (See 
Mass Storage Mode on page 90.)
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Menu Bar 3

 

1 Apply Settings to the Printer
Applies the settings to the printer.

Performs the same operation as when [Apply] is clicked.

2 Check Setting

Displays the setting currently registered.

3 Save Settings in Command File
Saves the specified settings in a command file.

Performs the same operation as when [Save in Command File] is selected from the [Apply] drop-down 
list.

4 Import
Imports the exported file.

5 Export

Saves the current settings in a file.

6 Save Print Log in File

Saves the print log in a file in the CSV format.
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7 Print Unit Settings
Prints a report containing firmware version and device setting information.

You can also print this report using the (Feed) / OK button (see Print the Printer Information 
on page 89).

8 Reset to Factory Defaults
Resets all printer settings to factory settings.

9 Reset only Device settings

Resets the settings that can be changed in the Device Settings to factory settings. The templates, 
databases and print log stored in the printer are not reset.

10 Delete Template and Database
Deletes the templates and databases stored in the printer.

11 Delete Print Log

Deletes the print log stored in the printer.

12 Option Settings

If the [Do not display an error message if the current settings cannot be retrieved at startup] check 
box is selected, a message will not be displayed next time.

13 About
Displays the version information.
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Basic Tab 3

 

1 Auto Power On
Specifies whether the printer turns on automatically when the AC Power Cord is plugged into an AC power 
outlet.
Available settings: [On], [Off]

2 Auto Sleep
Designates the amount of time to elapse before the Printer automatically goes into sleep mode.

Available settings: [Off], 1/2/3/4/5/6/7/8/9 minutes

3 Auto Power Off
Specify the amount of time that passes before the printer turns off automatically.

Available settings: [Off], 10/30 minutes, 1/3/6/9/12 hours

4 Battery Charge Level
Specify the maximum charge level.

Available settings: [80 %], [100 %]

Note
To get the longest life from the battery, select [80 %]. Although the number of pages that can be printed 
on a single charge will be less when you select [80 %], you can get a longer overall battery life.
 

5 Command Mode

Select the printer’s command format.
Available settings: [Raster], [ESC/P], [P-touch Template], [CPCL emulation], [CPCL Line Print 
emulation]
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6 Text Direction
Select the printing orientation.

Available settings: [Normal], [Inverted 180 Degrees]
This setting is applied only if the printer driver is not used. If the printer driver is used, the setting specified 
in the driver will be applied.

7 Print Speed

Select the printer’s printing speed.
Available settings: [3 ips / 76.2 mm/s], [4 ips / 101.6 mm/s], [5 ips / 127 mm/s]

8 Print Density

Adjust the printer’s printing density.
Available settings: -5–+5

9 Align Paper Leading Edge when the Cover is Closed

Select whether the paper is automatically fed when the cover is closed.
Available settings: [Feed], [Do not Feed]



Change the Printer Settings 

74

3

Advanced Tab 3

 

1 Feed Key Function

Select the operation that is performed when the (Feed) / OK button is pressed.
If [Program Settings] is selected, click the [File] button and select the command file.

Available settings: [Feed], [Disable], [Program Settings]

2 Menu Key Function

Select the operation that is performed when the Menu /  (Select) button is pressed.
If [Program Settings] is selected, click the [File] button and select the command file.

Available settings: [Menu], [Disable], [Program Settings]

3 Printer Information Report
Select which sections are printed when printing the printer setup information.

Available settings: [All], [Usage Log], [Printer Settings], [Printer Transfer Data]
(See Print the Printer Information on page 89)

4 JPEG Printing Setting

Selects the method of image processing when printing JPEG images.
Available settings: [Simple Binary], [Error Diffusion]

5 Serialize Mode
Select whether or not to serialize from the last number printed.

Available settings: [Cont From Last], [From Starting#]

6 Save Printer Print Log
Select whether or not to save the printer’s print log. If [Disable] is selected, [Maintenance] - [Save Print 
Log in File] cannot be enabled.

Available settings: [Enable], [Disable]
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7 Print Data after Printing
Select whether or not print data is erased automatically after it is printed.

Available settings: [Erase All Print Data], [Keep Print Data]

8 Airplane Mode
Disables the Bluetooth interface and Wi-Fi connection. This function is useful when you use the printer in 
a place where signal transmissions are not allowed.

Available settings: [On], [Off]

9 Linerless
Select to enable support for Linerless rolls.

Available settings: [On], [Off]
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Print Position / Sensor 3

If RD Rolls are being used, you do not need to adjust the sensors.
 

1 Printing Reference Point Adjustment Along Label Width / Printing Reference Point Adjustment 
Along Label Length

Adjust the position of the reference point (point of origin for printing). This corrects printing misalignments 
resulting from differences in printer models or from the fixed margins of some software.
The reference point cannot be adjusted for raster printing.

Available settings: [Along Label Width]: -5.91 in. to 5.91 in. (-150.0 mm to 150.0 mm), [Along Label 
Length]: -0.39 in. to 0.39 in. (-10.0 mm to 10.0 mm)

2 Tear Adjust
Adjust the tear bar tear off position for paper media.

Available settings: -0.39 in. to 0.39 in. (-10.0 mm to 10.0 mm)

3 Media Sensor (Transmissive/Gap)
The following transmissive/gap sensor parameters can be adjusted.

[Detection Sensitivity]
Adjust the precision of the sensor that detects the gaps (spacing) for die-cut labels.

Available settings: -2–+2
[Luminescence Adjustment]

Adjust the amount of light emitted by the transmissive/gap sensor.
Available settings: -2–+2
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4 Media Sensor (Reflective/Bar)
The following reflective/black mark sensor parameters can be adjusted.

[Mark Detection Sensitivity]
Adjust the precision of the sensor that detects the black marks.

Available settings: -2–+2
[Luminescence Adjustment]

Adjust the amount of light emitted by the reflective/black mark sensor.
Available settings: -2–+2
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Display Settings Tab 3

 

1 Language

Select the language for the LCD.
Available settings: [Dansk], [Deutsch], [English], [Español], [Français], [Italiano], [Nederlands], 
[Norsk], [Português], [Suomi], [Svenska], [ ], [ ]

Note
The available display languages may differ depending on the printer model being used. If the selected 
language cannot be used for the LCD, the display language will not be changed.
Make sure that the LCD can display the selected language.
 

2 LCD Contrast
Select the brightness of the LCD.

Available settings: -2–+2

3 Backlight Timeout
Specify the amount of time of inactivity before the backlight of the LCD turns off automatically.

Available settings: [Off], [5s], [10s], [20s], [30s], [60s]

4 Beeper
Select whether the printer beeps when it is turned on or off, or if an error occurs.

Available settings: [On], [Off]
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Apply Setting Changes to Multiple Printers 3

a After applying the settings to the first printer, disconnect the printer from the computer, and then connect 
the second printer to the computer.

b Select the newly connected printer from the [Printer] drop-down list.

c Click [Apply].
The same settings that were applied to the first printer are applied to the second printer.

d Repeat steps a – c for all printers whose settings you want to change.

Note
To save the current settings in a file, click [File] - [Export].

The same settings can be applied to another printer by clicking [File] - [Import], and then selecting the 
exported settings file. (See Device Settings on page 68.)
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P-touch Template Settings 3

P-touch Template mode provides functions for inserting data from an external device (such as a barcode 
reader, controller or programmable logic device connected to the printer) into text and barcode objects in 
layouts saved on the printer, useful for printing templates and barcodes.

With [P-touch Template Settings] in the Printer Setting Tool, settings for using the P-touch Template 
functions can be specified or changed.

To use the P-touch Template functions, you must send the template to the printer using the transfer function. 
For more information about the transfer function, see How to Use P-touch Transfer Manager & P-touch 
Library on page 103.

P-touch Template 3

The following are the P-touch Template functions:

Basic operations 3

 Preset template printing

If frequently used templates are stored in the printer, they can be reprinted by simply scanning the barcode 
for each template.

 Barcode printing

A barcode scanned with the barcode reader can be printed with the protocol and size of a previously 
created template.

 Database-assisted template printing

By linking objects in a template to a database, then scanning the key barcodes for the database, the 
template can be printed with objects in the template replaced with database data.

Advanced operations 3

 Numbering function (serialized number) printing

Templates can be printed while automatically incrementing a number or barcode in the templates.

Note
If a command reference is used, see the P-touch Template Manual/Command Reference. You can 
download the latest versions from the Brother support website:

1 Go to support.brother.com

2 Select your model, and then select [Manuals].
 

https://support.brother.com
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P-touch Template Settings Dialog Box 3

 

1 Default Command Mode
Specifies the P-touch Template mode as the default mode.

To change the mode, use the Device Settings.

2 Default Template Number
Specifies a template number to select as default when the printer is turned on.

However, if a template is not to be transferred to the printer, do not specify a template number.

3 Data Delimiter for P-touch Template
A symbol used to indicate the boundaries between groups of data in a file. Between 1 and 20 characters 
can be specified.

4 Trigger for P-touch Template Printing

You can specify a trigger to begin printing from a number of options.
[Command Character]: Printing starts when the command character specified here is received.

[Data Insertion into All the Objects]: Printing starts when the delimiter for the last object is received.
[Received Data Size]: Printing starts when the number of characters specified here is received. However, 
delimiters are not counted in the number of characters.

5 Character Code Table

Select one of the following character code sets:
Available settings: [Windows 1251], [Windows 1252], [Windows 1250 Eastern Europe], [Brother 
standard], [Unicode]
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6 International Character Set
Lists character sets for specific countries or regions.

Available settings: [United States], [France], [Germany], [Britain], [Denmark], [Sweden], [Italy], 
[Spain], [Japan], [Norway], [Denmark II], [Spain II], [Latin America], [Korea], [Legal]
The following 12 codes are switched depending on the country or region selected from the list above:

23h 24h 40h 5Bh 5Ch 5Dh 5Eh 60h 7Bh 7Ch 7Dh 7Eh

For switched characters, see the P-touch Template Manual/Command Reference (which can be 
downloaded from the Brother support website).

7 Command Prefix Character
Specifies the prefix character code, which identifies commands used in P-touch Template mode.

8 Non-Printed Character
Characters specified here are not printed when data is received. Specify 1 to 20 characters.

9 Available Return Code

The line feed code is used when feeding data to indicate that the following data should be moved to the 
next line in a text object. One of the following four line feed codes can be selected, or 1 to 20 characters 
can be specified as the line feed code.

Available settings: [^CR], [\0D\0A], [\0A], [\0D]

10 Replace FNC1

See the P-touch Template Manual/Command Reference.

11 Number of Copies
Set the number of copies. A number between 1 and 99 can be specified.

12 Inverted 180 Degrees

If this check box is selected, the data will be printed after it has been rotated 180 degrees.

13 Set

After the [Set] button is clicked, the settings are saved as an .ini file when the dialog box is closed.
To save the specified settings in a command file, select [Save in Command File] from the drop-down 
menu. The saved command file can be used with the mass storage feature to apply the settings to a 
printer. (See Mass Storage Mode on page 90.)

14 Cancel
Cancels the settings and closes the dialog box. The settings will remain unchanged.

15 Default
Click this button to return the settings to their factory defaults.
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Paper Size Setup 3

With [Paper Size Setup] in the Printer Setting Tool, paper sizes not available in the [Paper Size] list of the 
printer driver can be added. 

Before you print using a paper size other than the available ones, you must register the new paper size by 
sending it to the printer.

Printing with a paper size not registered with the printer may produce incorrect print results.

Paper Size Setup Dialog Box 3

 

1 Current settings

Displays the current settings for the selected paper format.

2 New

Click this button to display the [New] dialog box and register a new paper size. For details, see New Dialog 
Box on page 85.

Important
Do not register a paper size that has already been registered, to avoid incorrect print results.
To use paper of the same size as one that is currently registered, select the size you want from the 
[Currently Registered Paper Sizes] list in the [Paper Size Setup] dialog box, and then change and 
overwrite the settings from the [Edit] dialog box.
 

3 Edit
Edits the settings for the selected paper format.

To save the selected paper format with the new settings, click [Overwrite]. To add a paper format with the 
new settings, change the name in the [Paper Size Name] box, and then click [Add].

4 Delete
Deletes the selected paper format. A deleted paper format cannot be restored.
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5 Import
Reads the text file containing the paper format settings and uses it to replace the contents of the 
[Currently Registered Paper Sizes] list.

Important
When the list is imported, the entire contents of the [Currently Registered Paper Sizes] list will be 
replaced with the imported paper formats.
 

6 Export

Exports the paper formats in the [Currently Registered Paper Sizes] list to a file. The exported formats 
can then be distributed to other computers. For details, see Distribute Paper Formats on page 88.

7 Exit
Exits [Paper Size Setup], and returns to the main window of the Printer Setting Tool.

8 Option

Click the b button, and then select an operation.
Click [Register Paper Size With Printer] to register the settings for the selected paper format in the 
printer.

Click [Save in Command File] to export the paper settings as a command file. (The file extension is “.bin”.)

Note
• When the paper format is registered with the printer and [Exit] is clicked, the [Paper Size Setup] dialog 

box appears with the added paper size in the [Currently Registered Paper Sizes] list. If the software is 
running, exit the software, and then restart it for the new paper format to appear in the list.

• If the following functions are being used, you can quickly apply their settings to the printer.

• Mass storage feature (page 90)
• Bluetooth (Object Push Profile (OPP))

• Wi-Fi (File Transfer Protocol (FTP))
 

Important
These settings commands are only intended to be used for applying settings to a printer. These 
commands cannot be imported into [Paper Size Setup].
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New Dialog Box 3

 

1 Paper Size Name

Type in the name of the paper format to be added.

2 Paper Types
Select the paper type.

Available settings: [Continuous Length Tape], [Die-cut Label], [Media With Marks]

3 Detailed settings
Specify details for the paper format to be added.

4 Advanced Printing Adjustments
Click this button to display the [Advanced Printing Adjustments] dialog box and make advanced printing 
adjustments for each paper format. For details, see Advanced Printing Adjustments Dialog Box 
on page 86.

5 Cancel
Cancels the settings and closes the dialog box. The settings will remain unchanged.

6 Add
Click this button to add the paper format.

3

2

4
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Advanced Printing Adjustments Dialog Box 3

 

1 Printing Reference Point Adjustment

Adjust the position of the reference point (point of origin for printing). This corrects printing misalignments 
resulting from differences in printer models or from the fixed margins of some software.

2 Tear Adjust
Adjust the cutting position when the paper is cut using the tear bar.

Available settings: -0.39 in. to 0.39 in. (-10.0 mm to 10.0 mm)

3 Energy Rank
Select a setting when it is necessary to adjust the amount of heat (energy) from the print head, for 
example, with special paper.

Note
• When using “Premium Receipt Paper”*, select [RD 2.00" (50 mm)] in the [Paper Size Setup] dialog box, 

click the [Edit] button, and then set [Energy Rank] to [4] in the [Advanced Printing Adjustments] dialog 
box.

When using “Standard Receipt Paper”*, set [Energy Rank] to [2].
* Available paper types vary by country or region.

• There may be contrast variations in the print result due to the operating environment and media used. 
Change the setting if necessary.
 

4 Media Sensor (Transmissive/Gap)

Adjust the precision with which the transmissive/gap sensor detects the gaps (spacing) for die-cut labels 
and the amount of light emitted by the sensor.
Settings can be specified when [Paper Types] is set to [Die-cut Label].

3

4
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Note
Because the settings for [Media Sensor (Transmissive/Gap)] in the [Device Settings] dialog box (See 
Print Position / Sensor on page 76) will have an effect, specify appropriate values.
Example settings:

 

5 Media Sensor (Reflective/Bar)
Adjust the precision with which the reflective/black mark sensor detects black marks and the amount of 
light emitted by the sensor.

Settings can be specified when [Paper Types] is set to [Media With Marks].

Note
Because the settings for [Media Sensor (Reflective/Bar)] in the [Device Settings] dialog box (See Print 
Position / Sensor on page 76) will have an effect, specify appropriate values.
Example settings:

 

6 OK
Saves the settings and returns to the previous dialog box.

7 Cancel
Cancels the settings and closes the dialog box. The settings will remain unchanged.

Setting EX1 Setting EX2

Device Settings +2 -2

Paper Size Setup +2 +2

Actual effect 4 0

Setting EX1 Setting EX2

Device Settings +2 -2

Paper Size Setup +2 +2

Actual effect 4 0
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Distribute Paper Formats 3

The paper formats exported from the [Currently Registered Paper Sizes] list can be distributed to other 
computers.

Distributing Only Paper Formats 3

If the printer driver has been installed on the recipient’s computer, only the paper formats need to be 
distributed.

a At the sender’s computer, specify the paper format settings, and then click [Export]. (For details, see 
Paper Size Setup on page 83.)
The following files are created: bsr425ed.txt, bsr425ed.ptd, pdt4437.bin or bsr423ed.txt, bsr423ed.ptd, 
pdt4337.bin

b Save bsr425ed.txt or bsr423ed.txt in any location on the recipient’s computer.

c At the recipient’s computer, click [Import].
The paper formats are replaced with the imported ones.

Change Settings When Printing from a Mobile Device 3

If using a mobile device, change the settings as necessary using the software before printing. The settings 
that can be changed vary according to the software.

Note
Before connecting a mobile device, you can specify detailed settings by connecting the printer to a 
computer, and using the Printer Setting Tool (see Change the Printer Settings on page 46).
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Print the Printer Information 4

You can use the (Feed) / OK button to print a report that lists the following printer information:

 Program version

 Printer usage history

 Missing dot test pattern

 Printer settings information

 List of transferred data

 Network setting information

Note
• You can use the Device Settings to set in advance which items will be printed (see Device Settings 

on page 68).

• The node name appears in the Printer Settings. The default node name is “BRWxxxxxxxxxxxx”. (Where 
“xxxxxxxxxxxx” is based on the printer’s MAC Address/Ethernet Address.)

• This operation can also be performed using the Printer Setting Tool.
 

a Make sure that a roll of receipt paper has been loaded and the roll compartment cover is closed.

b Turn on the printer.

c Press and hold the (Feed) / OK  button until [Printing] appears on the LCD. The printer information 
will be printed.

Note

To print a printer information, use 4 in. (102 mm) continuous roll.
 

Other Functions 4
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Mass Storage Mode 4

Description 4

The mass storage mode feature allows you to send a file via the USB interface without loading a printer driver.

This feature is useful for:

 Applying printer settings saved in a command file (.bin file format) or adding templates (.blf file format) 
distributed by the administrator, to the printer.

 Executing commands without installing the printer driver.

 Using a device with an operating system (including non-Windows operating systems) that has a USB host 
feature to print and transmit data.

Use of Mass Storage Mode 4

a Confirm that the printer is turned off.

b While pressing the Menu /  (Select) button, press and hold the (Power) button.
The printer starts up in mass storage mode. The message [Mass Storage] appears on the LCD.

c Connect the Windows computer or mobile device to the printer via USB.
The printer’s mass storage area is displayed on the computer or device’s screen.

Note
If the mass storage area is not displayed automatically, see the operating instructions for the computer or 
device’s operating system for information about displaying the mass storage area.

 

d Drag and drop the file you want to copy to the mass storage area.

e Press the Menu /  (Select) button.
The command file is executed. The message [Receiving] appears on the LCD.

f After the file has been executed, the message [Mass Storage] appears on the LCD.

g To turn mass storage mode off, turn off the printer.
The printer will start up in its normal operating mode.
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Important
• When the printer is turned off, mass storage mode is deactivated and any files in the mass storage area 

are deleted.

• This feature supports “.bin”, “.blf”, and “.jpg” files. Do not use other file formats with this feature.

• Do not create folders in the mass storage area. If a folder is created, files in the folder will not be executed.

• The capacity of the mass storage area is 15.8 MB.

• If multiple files are copied, the order that the files will be executed in cannot be guaranteed.

• Wi-Fi and Bluetooth are not available while the printer is running in mass storage mode.

• Do not access other files in the mass storage area when executing a copied file.
 

Print JPEG Images 4

Image data (JPEG) can be printed without using the printer driver.

Note
• JPEG images can be printed using the mass storage feature.

• The Object Push Profile (OPP) is used for printing via a Bluetooth connection.

• This printer will convert a color JPEG image to a ‘Black & White’, image using a dithering process.

• When sending a JPEG image that is already ‘Black & White’ this dithering process may make your printed 
image fuzzy.

• To improve the image quality, try to turn off any preprocessing of the JPEG image.
 

 Only JPEG images can be printed. (Limited to files with the .jpg extension.)

 The maximum file size is 15.8 MB.

 The maximum resolution is as follows:

Height  Width = 24000  832 dots

If these limits are exceeded, the data received by the printer will be discarded and not printed.

 Print is at 1 pixel = 1 dot.

 This printer performs binary processing (simple binary) to print the image.

 The image is printed with the height-to-width proportion of the received data.

Remote Update (RJ-4250WB Only) 4

The Remote Update feature allows for the semi-automatic update of the printer's settings with a simple 
connection to a network folder where the update files reside. For more information about Remote Update, 
see Remote Update (RJ-4250WB only) on page 43.
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Use of P-touch Editor 5

You must install P-touch Editor and the printer driver to use the printer with Windows computer.
To download the latest driver and software, visit our website at: 
install.brother

Start P-touch Editor 5

a For Windows 10 / Windows Server 2016 (RJ-4250WB)
Click [Start] > [P-touch Editor 5.2] under [Brother P-touch], or double-click the [P-touch Editor 5.2] 
icon on the desktop.

For Windows 8/ Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2 
(RJ-4250WB)
Click [P-touch Editor 5.2] on the [Apps] screen or double-click the [P-touch Editor 5.2] icon on the 
desktop.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB)
Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Editor 5.2], or double-click the [P-touch 
Editor 5.2] shortcut icon on the desktop.

b When P-touch Editor starts, select whether you want to create a new layout or open an existing layout.

Note
To change how P-touch Editor starts, click [Tools] > [Options] in the P-touch Editor menu bar to display 
the [Options] dialog box. On the left side, select the [General] heading and then the setting you want in 
the [Operations] list box under [Startup Settings]. The factory setting is [Display New View].

 

How to Use P-touch Editor 5

http://install.brother/
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c Select an option in the screen.
 

1 To create a new layout, double-click [New Layout], or click [New Layout] and then click [ ].

2 To create a new layout using a preset layout, double-click a category button, or select a category 
button and then click [ ].

3 To connect a pre-set layout to a database, select the check box next to [Connect Database].

4 To open an existing layout, click [Open].

2

1

4
3
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Print with P-touch Editor 5

 Express mode

This mode allows you to quickly create layouts that include text and images.
 

Configure the settings in the Print screen before printing.

To print, click [File] > [Print] from the menu bar or click the print icon.

 Professional mode

This mode allows you to create layouts using a wide-range of advanced tools and options.
 

Configure the settings in the Print screen before printing.

To print, click [File] > [Print] from the menu bar or click the print icon (A).

In addition, click the [Print] icon (B) to start printing without changing the settings.

B

A
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 Snap mode

This mode allows you to capture all or a portion of your computer screen content, print it as an image, and 
save it for future use.

a Click the [Snap] mode selection button.
The [Description of Snap mode] dialog box appears.
 

b Click [OK].
The [Snap] mode palette appears.
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Tips for Creating Templates 5

From the computer, use P-touch Editor 5.2, which can be downloaded from the website at install.brother, to 
create a label layout. For more information about its use, see How to Use P-touch Editor on page 93.

Create a Template 5

Label sample
 

a For Windows 10 / Windows Server 2016 (RJ-4250WB)
Click [Start] > [P-touch Editor 5.2] under [Brother P-touch], or double-click the [P-touch Editor 5.2] 
icon on the desktop.

For Windows 8/ Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2 
(RJ-4250WB)
Click [P-touch Editor 5.2] on the [Apps] screen or double-click the [P-touch Editor 5.2] icon on the 
desktop.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB)
Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Editor 5.2], or double-click the [P-touch 
Editor 5.2] shortcut icon on the desktop.

b When P-touch Editor starts, select whether you want to create a new layout or open an existing layout.

http://install.brother/
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c Click [Paper] (1), and then specify the media and length (2). (This example shows the [Express] mode.)
 

d Click [Text] (1), and then specify the font and style (2).
 

1

2

1

2
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e Clicking  displays the cursor so text can be entered.
 

f After adding the text, click the text box to move it within the template.

g Repeat steps e and f to enter text and arrange the layout.

h [File] > [Save as] on the menu bar, and then specify a file name to save the template.
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Insert the Date and Time in a Label 5

a In P-touch Editor 5.2, open the label layout you want to edit.

b On the menu bar, click [Insert] > [Date/Time] to display the [Date and Time Properties] dialog box. 
Select settings for the format of the text you want to insert.
 

Important
The date and time inserted into the label will be printed using the printer's default character size. Because 
the character size is determined by the size of the date and time object, adjust the object to the size you 
want in P-touch Editor 5.2 before transferring the label layout to the printer.
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Link a Database to a Template 5

 Label sample
 

A database can be linked to the template you created. Since the text in the template can be replaced with text 
from the database, multiple labels can be printed simply by creating a single template.

For more information on how to create databases and database settings, see [P-touch Editor Help].

a Prepare a database file in advance.

Note
• Files saved as XLS, XLSX, MDB, CSV, TXT and ACCDB formats can be used as databases.

• Only one database can be linked to a single template. A maximum of 65,000 records can be created in 
that database. (The total size of templates and databases combined is limited to 12 MB.)

 

b In P-touch Editor 5.2, open the template to be linked to the database.

c On the menu bar, click [File] - [Database] - [Connect] or  to display the [Open Database] dialog box. 
Select [Connect Database File], click [Browse], and then select the database you want to link.
 

Click [Next].
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d With [Database Field] under [Merge Fields], specify which database column will be linked to which 
object, and then click [OK].
 

e The template and database will be linked, and the main window appears. Click to select the database 
row with the text to be replaced, and display a preview of the label.
 

Finally, transfer the created template to the printer using P-touch Transfer Manager.

For details, see How to Use P-touch Transfer Manager & P-touch Library on page 103.
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P-touch Transfer Manager 6

This program allows you to transfer templates and other data to the printer and save backups of your data on 
Windows computer.

First P-touch Transfer Manager transfers data to the printer, and then P-touch Template sends text data that 
will be inserted into the template and printed. For more information on P-touch Template, download the 
P-touch Template Manual/Command Reference (English only) from the Brother support website at 
support.brother.com/manuals.

The transfer function is needed to use P-touch Template.

The template can also be transferred via network.

How to Use P-touch Transfer Manager & 
P-touch Library 6

https://support.brother.com/manuals
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Transfer the Template to P-Touch Transfer Manager 6

To use P-touch Transfer Manager, you must first transfer templates created in P-touch Editor to P-touch 
Transfer Manager.

a In P-touch Editor, open the template you want.

b Click [File] > [Transfer Template] > [Transfer].

When P-touch Transfer Manager starts, the main window appears.

Note
The following method can also be used to start the P-touch Transfer Manager.

For Windows 10 / Windows Server 2016 (RJ-4250WB):

Click [Start] > [P-touch Transfer Manager 2.3] under [Brother P-touch].

For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2 
(RJ-4250WB): 
Click [P-touch Transfer Manager 2.3] on the [Apps] screen.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB): 
Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Tools] > [P-touch Transfer Manager 2.3].

 



How to Use P-touch Transfer Manager & P-touch Library 

105

6

Main window 6

 

1 Menu bar

Provides access to various commands, which are grouped under each menu title ([File], [Edit], [View], 
[Tool], and [Help]) according to their functions.

2 Toolbar
Provides access to frequently used commands.

3 Printer selector

Allows you to select which printer the data will be transferred to. When you select a printer, only the data 
that can be sent to the selected printer is displayed in the data list.

4 Folder list
Displays a list of folders and printers. When you select a folder, the templates in the selected folder are 
displayed in the template list.

If you select a printer, the current templates and other data stored in the printer are displayed.

5 Template list
Displays a list of templates in the selected folder.

6 Preview

Displays a preview of the templates in the templates list.

2

4

1
3

5

6
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Explanations of the Toolbar Icons

Icon Button name Function

 

Transfer
Transfers templates and other data from the computer to the 
printer.

Save Transfer File

(When not connected to a 
printer)

Changes the file type of the data to be transferred to other software.

Select "BLF" for the filename extension when transferring the data 
using Wi-Fi. Select "PDZ" when transferring the data using 
P-touch Transfer Express (USB).

The available interfaces differ depending on your model.
 

Backup
Retrieves the templates and other data saved in the printer and 
saves it to a computer.

 

Open Opens the selected template.

 

Search
Allows you to search for templates or other data that are registered 
to P-touch Library.

 

Display Style Changes the file display style.
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Transfer Templates or Other Data from Computer to the 
Printer 6

Use the following procedure to transfer templates, databases and images from the computer to the printer.

a Connect the computer and the printer via USB, and then turn on the printer.
The printer model name appears next to a printer icon in the folder view.
If you select the printer in the folder view, the current templates and other data stored in the printer 
appear.

Note
• If a printer is disconnected or offline, it is not listed in the folder view.

• Before transferring data, check that the computer and the printer are correctly connected via a USB cable 
or Wi-Fi, and that the printer is on.

 

b Select the printer that you want to transfer the template or other data to.
 

c Right-click the [Configurations] folder, select [New], and then create a new folder.
 



How to Use P-touch Transfer Manager & P-touch Library 

108

6

d Drag the template or other data that you want to transfer and place it in the new folder.

Note
You can confirm the available space in the transfer file memory by printing the Printer Setting Report. For 
more information, see Print the Printer Information on page 89. 
See [RomFree] for the available space*.

* The available space that appears in "RomFree = *******byte" may be different from the actual available 
space.

 

You can view the templates and other data by selecting:

 The folder in the [Configurations] folder

 [All Contents]

 One of the categories under [Filter], such as [Layouts]

When transferring multiple templates or other data, drag all the files you want to transfer and place them 
in the new folder.

Each file is assigned a key number (memory location in the printer) when it is placed in the new folder.
 

Transfer Function Specification

Data type
Maximum number of 

transferable items
Restriction details

Template 255  Each template can contain a maximum of 255 objects.

Database 255
 Only *.csv files can be transferred.

 Each *.csv file can contain a maximum of 65000 records.

Image 
(User-defined 
character)

255

 Only *.bmp files can be transferred.

 Monochrome *.bmp files are recommended.

 The size limit is 832  832 pixels.
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e To change the key number assigned to an item, right-click the item, select [Key Assign], and then select 
the key number you want.
 

Note

• Except for the data in databases, all data transferred to the printer is assigned a key number.

• If the template or other data transferred to the printer has the same key number as another template 
already saved in the printer, the new template will overwrite the old one. You can confirm the templates 
key number assignments saved in the printer by backing up the templates or other data. For more 
information, see Back up Templates or Other Data Saved in the Printer on page 111.

• If the printer memory is full, remove one or more templates from the printer's storage memory. For more 
information, see Back up Templates or Other Data Saved in the Printer on page 111.

 

f To change the names of templates or other data that will be transferred, click the item you want, and 
then type the new name. The number of characters used for the template names may be limited 
depending on the printer model.

g Select the folder containing the templates or other data that you want to transfer, and then click 
[Transfer]. A confirmation message appears.
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Note
• You can also transfer individual items to the printer without adding them to a folder. Select the template or 

other data that you want to transfer, and then click [Transfer].

• Multiple items and folders can be selected and transferred in one operation.
 

h Click [OK].
 

The selected items are transferred to the printer.
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Back up Templates or Other Data Saved in the Printer 6

Use the following procedure to retrieve the templates or other data saved in the printer and save it to a 
computer.

Important
• Backed up templates or other data cannot be edited on the computer.

• Depending on the printer model, templates or other data backed up from one printer model may not be 
able to be transferred to another printer model.

 

a Connect the computer and the printer and turn on the printer.
The printer model name is displayed in the folder view.
If you select a printer in the folder view, the current templates and other data stored in the printer are 
displayed.

b Select the printer to back up from, and then click [Backup].
A confirmation message appears.
 

c Click [OK].
A new folder is created under the printer in the folder view. The folder name is based on the date and 
time of the backup. All of the printer's templates and other data are transferred to the new folder and 
saved on the computer.
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Delete Printer Data 6

Use the following procedure to delete all templates or other data that are saved in the printer.

Important
This feature is only available when the computer and printer are connected via USB.

 

a Connect the computer and the printer.
The printer model name appears next to a printer icon in the folder view.

b Right-click the printer, and then select [Delete All].
 

A confirmation message appears.
 

c Click [OK].
All templates and other data saved in the printer are deleted.
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Create Transfer Files and Transfer Package Files 6

You can use P-touch Transfer Manager to save template data, which was created using P-touch Editor, in 
the .blf or .pdz format. You can transfer these files in this format to a printer, from a computer or mobile device. 
You can also print files in BLF format when the printer is in mass storage mode.

a Create the template using P-touch Editor, and then transfer it to P-touch Transfer Manager.
For more information, see Transfer the Template to P-Touch Transfer Manager on page 104.

b Without connecting the printer to the computer, select [Configurations] in the P-touch Transfer Manager 
window, and then select the template to save.

Note
You can select multiple templates at the same time.

 

c Click [File] > [Save Transfer File].

Important
The [Save Transfer File] button appears only if the printer is disconnected from the computer or offline.

 

Note
• If you click [Save Transfer File] after selecting [Configurations], all templates in the folder are saved as 

the BRAdmin file (.blf) or Transfer Package file (.pdz).

• You can combine multiple templates into a single BRAdmin file (.blf) or Transfer Package file (.pdz).
 

d In [Save as type], select the format in which to save the template, and then type in the name and save 
the template.
Select the BLF format when printing using the mass storage mode or connecting your mobile device to 
the printer using Wireless Direct or Wi-Fi, and select the PDZ format when connecting using Bluetooth.
The templates are saved as a BRAdmin file (.blf) or Transfer Package file (.pdz).
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Use of P-touch Library 6

This program allows you to manage and print P-touch Editor templates.

Start P-touch Library 6

For Windows 10 / Windows Server 2016 (RJ-4250WB):

Click [Start] > [P-touch Library 2.3] under [Brother P-touch].

For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2 
(RJ-4250WB):

Click [P-touch Library 2.3] on the [Apps] screen.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB):

Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Tools] > [P-touch Library 2.3].

When P-touch Library starts, the main window appears.

Main window 6

 

1 Menu bar
Provides access to all available commands, which are grouped under each menu title ([File], [Edit], 
[View], [Tool], and [Help]) according to their functions.

2 Toolbar

Provides access to frequently used commands.

3 Folder list
Displays a list of folders. When you select a folder, the templates in the selected folder are displayed in 
the templates list.

2

3

1

4

5
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4 Templates list
Displays a list of the templates or other data in the selected folder.

5 Preview

Displays a preview of the templates or other data selected in the templates list.

Explanations of the Toolbar Icons

Icon Button name Function
 

Open Opens the selected template.

 

Print Prints the selected template with the printer.

 

Search Allows you to search for templates registered to P-touch Library.

 

Display Style Changes the file display style.
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Open and Edit Templates 6

Select the template you want to open or edit, and then click [Open].
 

The program associated with the template starts, and lets you edit the template.
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Print Templates 6

Select the template you want to print and then click [Print].
 

The connected printer prints the template.
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Search for Templates 6

You can search for templates registered to P-touch Library.

a Click [Search].
The [Search] dialog box appears.
 

b Specify the search criteria.
The following search criteria are available:

c Click [Begin Search].
The search begins and the search results are displayed.

d Close the [Search] dialog box.
To confirm the search results, click [Search Results] in the folder view.

Settings Details

Multiple Parameters Determines how the program searches when multiple criteria are specified. If you select 
[AND], the program searches for files that satisfy all of the criteria. 
If you select [OR], the program searches for files that satisfy any of the criteria.

Name Allows you to search for a template by specifying the file name.

Type Allows you to search for a template by specifying the file type.

Size Allows you to search for a template by specifying the file size.

Date Allows you to search for a template by specifying the file date.
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Note
You can register templates to P-touch Library by dragging and dropping them into the [All Contents] folder 
or to the folder list. You can also configure P-touch Editor to register templates to P-touch Library 
automatically, using the following procedure:

1 From the P-touch Editor menu, select [Tools] > [Options].

2 In the [Options] dialog box, click [General] > [Registration Settings].

3 Select the timing for registering templates created with P-touch Editor, and then click [OK].
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You can transfer templates to the printer using P-touch Transfer Express. First, the administrator creates a 
template, and then distributes it together with P-touch Transfer Express. You can then use P-touch Transfer 
Express to transfer the template directly to the printer.

To download the latest version of P-touch Transfer Express, visit support.brother.com and go to your model's 
[Downloads] page.

Important
• To transfer the file as a new template, specify a [Key Assign] number (in P-touch Transfer Manager) that 

is not currently used. If the specified [Key Assign] number is already being used, the existing template 
will be overwritten with the new one.

• This function requires a USB connection.
 

Prepare P-touch Transfer Express 7

You must prepare P-touch Transfer Express for transferring templates to a printer.

Important
• The printer driver must be installed before using P-touch Transfer Express.

• P-touch Transfer Express is available only in English.
 

a To download the latest version of P-touch Transfer Express, visit support.brother.com and go to your 
model's [Downloads] page.

b Download P-touch Transfer Express to any location in Windows computer.

c Decompress the downloaded file (.zip).

How to Transfer Templates with P-touch 
Transfer Express 7

Administrator Users
 

Brother support website
support.brother.com

P-touch
 Editor

P-touch 
Transfer Manager

Transfer Express

xxx.lbx xxx.lbx xxx.pdz

1.

2. 3. 4. 5.

P-touch 
Transfer Express

xxx.pdz

https://support.brother.com
https://support.brother.com
https://support.brother.com
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Transfer the Template to P-Touch Transfer Manager 7

a In P-touch Editor, open the template you want to use.

b Click [File] > [Transfer Template] > [Transfer].
 

The template is transferred to P-touch Transfer Manager.
P-touch Transfer Manager automatically starts up.

Note
• For Windows 10 /Windows Server 2016 (RJ-4250WB): 

The template can also be transferred to P-touch Transfer Manager by clicking [Start] > [Brother P-touch] 
> [P-touch Transfer Manager 2.3] to start P-touch Transfer Manager, and then dragging the .lbx file onto 
the P-touch Transfer Manager window.

• For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2 
(RJ-4250WB): 
The template can also be transferred to P-touch Transfer Manager by clicking [P-touch Transfer 
Manager 2.3] on the [Apps] screen to start P-touch Transfer Manager, then dragging the .lbx file onto the 
P-touch Transfer Manager window.

• For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB): 
The template can also be transferred to P-touch Transfer Manager by clicking [Start] > [All Programs] > 
[Brother P-touch] > [P-touch Tools] > [P-touch Transfer Manager 2.3] to start P-touch Transfer 
Manager, then dragging the .lbx file onto the P-touch Transfer Manager window.
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Save the Template as a Transfer Package File (.pdz) 7

To create a file in a format that can be used by P-touch Transfer Express, save the template as a Transfer 
Package file (.pdz).

a In the folder view, select [Configurations].
 

b Select the template you want to distribute.
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c Click [File] > [Save Transfer File].
 

Important
The [Save Transfer File] button appears only if the printer is disconnected from the computer or offline.

 

Note
• If you click [Save Transfer File] after selecting [Configurations] or a created folder, all templates in the 

folder are saved as the Transfer Package file (.pdz).

• You can combine multiple templates into a single Transfer Package file (.pdz).
 

d Type in the name, and then click [Save].
 

The template is saved as a Transfer Package file (.pdz).
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Distribute the Transfer Package File (.pdz) and P-Touch 
Transfer Express to the User 7

Note
If you already have P-touch Transfer Express downloaded, it is not necessary for the administrator to send 
the Transfer Express folder. In this case, you can simply move the distributed Transfer Package file to the 
downloaded folder, and then double-click [PtTrExp.exe].

 

a Move the Transfer Package file (.pdz) to the downloaded folder.
 

b Distribute all the files in the downloads folder to others.
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Transfer the Transfer Package File (.pdz) to the Printer 7

Using the P-touch Transfer Express software received from the administrator, you can transfer the Transfer 
Package file (.pdz) to the printer.

Important
Do not turn off the power when transferring templates.

 

a Turn on the printer.

b Using a USB cable, connect the printer to the computer.

c Double-click [PtTrExp.exe], which was received from the administrator.

d Transfer a Transfer Package file (.pdz) to the printer.

 Transferring a single Transfer Package file (.pdz)

1 When there is a single Transfer Package file (.pdz) within the folder containing [PtTrExp.exe], click 
[Transfer].
 

2 The transfer of the Transfer Package file begins.
 



How to Transfer Templates with P-touch Transfer Express 

126

7

 Transferring multiple Transfer Package files (.pdz)

1 When there are either multiple or no Transfer Package files (.pdz) within the folder containing 
[PtTrExp.exe], click [Browse].
 

2 Select the Transfer Package file you want to transfer, and then click [Open].
 

3 Click [Transfer].
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4 Click [Yes].
 

5 The transfer of the Transfer Package file begins.
 

e Click [OK].
 

The transfer of the Transfer Package file is completed.
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The software can be upgraded to the latest available version using the P-touch Update Software.

Note
• The actual software and the contents of this manual may differ.

• Do not turn off the power when transferring data or updating firmware.
 

Update P-touch Software 8

Important
Before updating software, install the printer driver.

 

a For Windows 10 / Windows Server 2016 (RJ-4250WB)
Click [Start] > [Brother P-touch] > [P-touch Update Software], or double-click [P-touch Update 
Software] on the desktop.

For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2 
(RJ-4250WB)
Click [P-touch Update Software] on the [Apps] screen or double-click [P-touch Update Software] on 
the desktop.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB)
Double-click the [P-touch Update Software] icon.

Note
The following method can also be used to start the P-touch Update Software.

Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Update Software].
 

 

How to Update P-touch Software 8
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b Click the [Computer software update] icon.
 

c Select the [Printer] and [Language], select the check box next to the software you want to update and 
then click [Install].
 

d A message appears to indicate the installation has finished.
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Update the Firmware 8

Important
• Before updating the firmware you must install the printer driver.

• Do not turn off the power when transferring data or updating firmware.

• If other software is running, exit the software.
 

a Turn on the printer and connect the USB cable.

b For Windows 10 / Windows Server 2016 (RJ-4250WB)
Click [Start] > [Brother P-touch] > [P-touch Update Software], or double-click [P-touch Update 
Software] on the desktop.

For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2 
(RJ-4250WB)
Click [P-touch Update Software] on the [Apps] screen or double-click [P-touch Update Software] on 
the desktop.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB)
Double-click the [P-touch Update Software] icon.

Note

The following method can also be used to start the P-touch Update Software. 
Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Update Software].
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c Click the [Machine update] icon.
 

d Select the [Printer], make sure that [The machine is connected correctly.] message appears, and 
then click [OK].
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e Select the [Language], select the check box next to the firmware to be updated, and then click 
[Transfer].

Important
Do not turn off the printer or disconnect the cable during data transfer.

 

 

f Check the content to be updated, and then click [Transfer] to begin the update. 
The firmware update begins.

Note
Do not turn off the printer or disconnect the cable during the update process.
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Network Features 9

The printer can be shared on an IEEE 802.11a/b/g/n wireless network using the internal network print server. 
The print server supports various functions and methods of connection on a network supporting TCP/IP, 
depending on the operating system you are running.

Wireless Network (RJ-4250WB Only) 9
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How to Change the Printer's Network Settings 
(IP Address, Subnet Mask and Gateway) 9

Use of BRAdmin Light Utility 9

The BRAdmin Light utility is designed for the initial setup of Brother network connectable devices. It can also 
search for Brother products in a TCP/IP environment, show the status and configure basic network settings, 
such as the IP address.

Install BRAdmin Light 9

a Visit our website (install.brother) and download the installer for the software and manuals.

b Double-click the downloaded .exe file and follow the on-screen instructions to proceed with the 
installation. In the dialog box for selecting which items to install, select BRAdmin Light.

Note

• If you require more advanced printer management, use the latest Brother BRAdmin Professional utility 
available as a download from the Brother support website at support.brother.com.

• If you are using firewall, anti-spyware, or antivirus software, temporarily disable them. When you are sure 
that you can print, re-enable them.

• The node name appears in the current BRAdmin Light window. The default node name of the print server 
in the printer is “BRWxxxxxxxxxxxx”. (“xxxxxxxxxxxx” is based on the printer’s MAC Address / Ethernet 
Address.)

• If required, enter the password "initpass".
 

Set the IP address, Subnet Mask and Gateway using BRAdmin Light 9

a Start the BRAdmin Light utility.

 Windows 10 / Windows Server 2016:

Click [Start] > [BRAdmin Light] under [Brother].

 Windows 8 / Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2:

Click [BRAdmin Light] icon on the [Apps] screen.

 Windows 7 / Windows Server 2008 / Windows Server 2008 R2:

Click [Start] > [All Programs] > [Brother] > [BRAdmin Light] > [BRAdmin Light].

b BRAdmin Light searches for new devices automatically.

http://install.brother/
https://support.brother.com
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c Double-click the new, unconfigured device.
 

Note
If you do not use a DHCP/BOOTP/RARP server, the device appears as [Unconfigured] in the BRAdmin 
Light utility screen.

 

d Select [STATIC] for the [Boot Method]. Enter the [IP Address], [Subnet Mask] and [Gateway] (if 
needed) of your print server.
 

e Click [OK].

f With a correctly programmed IP address, the Brother print server appears in the device list.
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Other Management Utilities 9

The printer can be used with the following management utilities in addition to the BRAdmin Light utility. You 
can change your network settings using these utilities.

Use Web Based Management (Web Browser) 9

A standard web browser can be used to change your print server settings using the HTTP (Hyper Text 
Transfer Protocol). (See Configure the Printer Settings Using Web Based Management (Web Browser) 
on page 138.)

Use of the BRAdmin Professional Utility 9

BRAdmin Professional is a utility for more advanced management of network connected Brother devices. 
This utility can search for Brother products on your network, and show the device status from an easy to read 
Explorer style window that changes color to represent the status of each device.

Note
• Please use the latest version of the BRAdmin Professional utility available as a download from the Brother 

support website at support.brother.com.

• The node name appears in the current BRAdmin Professional window. The default node name is 
“BRWxxxxxxxxxxxx”. (“xxxxxxxxxxxx” is based on the printer’s MAC Address / Ethernet Address.)

• If you are using firewall, anti-spyware, or antivirus software, temporarily disable them. When you are sure 
that you can print, re-enable them.

• If required, enter the password "initpass".
 

https://support.brother.com
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Web Based Management 9

You can use a standard web browser to manage a printer on your network using HTTP. When using Web 
Based Management, you can do the following:

 Display the printer status information

 Change network settings such as TCP/IP information

 Display software version information of the printer and print server

 Change network and printer configuration details

Note

• We recommend Microsoft Internet Explorer 11/Edge for Windows. Make sure that JavaScript and Cookies 
are always enabled in whichever browser you use.

• The default login password to manage printer settings is initpass. We recommend you change it to protect 
your printer from unauthorized access.

 

To use Web Based Management, your network must use TCP/IP, and the printer and Windows computer 
must have a valid IP address.
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Configure the Printer Settings Using Web Based Management 
(Web Browser) 9

A standard web browser can be used to change your print server settings using the HTTP (Hyper Text 
Transfer Protocol).

a Type http://printer_ip_address/ into your browser. (Where printer_ip_address is the IP 
address or the print server name.)

 For example (if the printer’s IP address is 192.168.1.2.):

http://192.168.1.2/

Note
If you have edited the hosts file on your computer or are using a Domain Name System, you can also enter 
the DNS name of the print server. As the print server supports TCP/IP and NetBIOS, you can also enter 
the NetBIOS name of the print server. You can find the NetBIOS name on the printer settings page. The 
NetBIOS name assigned is the first 15 characters of the node name and by default it appears as 
“BRWxxxxxxxxxxxx” where “xxxxxxxxxxxx” is the Ethernet address.

 

b You can now change the print server settings.

Note
Set a password

We recommend to change a login password to prevent unauthorized access to the Web Based 
Management.

a Click [Administrator].

b Enter the password you want to use (up to 32 characters).

c Re-enter the password in [Confirm new password] box.

d Click [Submit].
The next time you access Web Based Management, enter a password in the [Login] box, and then 

click .

After configuring the settings, logout by clicking .

You can also set a password by clicking [Please configure the password] on the printer’s web page if 
you are not setting a login password.
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Maintenance of the printer may be carried out as required. However, some environments may require more 
frequent maintenance (for example, dusty environments).

Exterior Maintenance 10

Wipe any dust and marks from the main unit using a soft, dry cloth.

Use a cloth slightly dampened with water on difficult to remove marks.

Note

Do not use paint thinner, benzene, alcohol, or any other organic solvent.

These may deform or damage the case of the printer.
 

Print Head Maintenance 10

Wipe the print head with a lint-free cloth dipped in isopropyl alcohol or ethanol. Carry out the maintenance 
frequently.
 

1 Print head

Note
Use according to the manufacturer's safety guidelines, as applicable.

 

Printer Maintenance 10

1
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Roller Maintenance 10

Wipe the roller with a lint-free cloth dipped in isopropyl alcohol or ethanol. After cleaning the roller, make sure 
that no lint or other material remains on the roller.
 

1 Roller

Note
Use according to the manufacturer's safety guidelines, as applicable.

 

Paper Exit Slot Maintenance 10

If adhesive accumulates at the paper exit slot and media becomes jammed or if the paper exit slot becomes 
dirty, wipe the paper exit slot with a lint-free cloth dipped in isopropyl alcohol or ethanol.
 

1 Paper exit slot

Note
Use according to the manufacturer's safety guidelines, as applicable.

 

1

1
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Linerless Platen Upgrade Maintenance 10

When using Linerless Platen Upgrade (PA-LPR-001), a dust or paper powder is attached to the print head 
easily. Clean the print head regularly to wipe the print head shown in the illustration with a lint-free cloth or 
cotton swab dipped in isopropyl alcohol or ethanol. After cleaning the print head, make sure that no lint or 
other material remains on the print head.
 

Note
It is NOT recommended to clean the linerless platen to avoid deterioration of the non-stick surface.
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Product Specifications 11

Items
Printing
Printing technology Direct Thermal
Print resolution 203 dpi x 203 dpi
Print speed* Maximum 5 ips (127 mm/s)

Maximum 3 ips (76 mm/s) (When linerless media is used.)
Maximum print width 4.09 in. (104 mm)
Maximum print length 118.1 in. (3 m)
Minimum print length 0.5 in. (12.7 mm)
Size
Weight (including battery) Approximately 1.87 lb./850 g
Dimensions Approximately 6.02 (W) x 6.26 (D) x 2.67 (H) in. / 153 mm (W) x 159 mm (D) x 68 

mm (H)
Interface
USB USB Ver. 2.0 (Full Speed) (mini-B)
Bluetooth Version 4.2

Supported profiles: SPP, OPP, HCRP, GATT

Supported protocol: iAP
Wireless LAN 
(RJ-4250WB only)

IEEE 802.11g/n (Wireless Direct)

IEEE 802.11a/b/g/n (Infrastructure Mode)

WPS 2.0
Environment
Operating temperature Operate: 

The battery: -4°F to 131°F (-20°C to 55°C)

AC adapter: 14°F to 104°F (-10°C to 40°C)

Car adapter: 14°F to 122°F (-10°C to 50°C)

50°F to 86°F (10°C to 30°C) (When linerless media is used.)

Charge:

32°F to 104°F (0°C to 40°C) (recommendable: 41°F to 95°F/5°C to 35°C)

If the internal temperature of the battery is out of this range, charging may stop.
Operating humidity 10% to 90% (No condensation, Maximum wet bulb temperature: 80.6°F/27°C) 

20% to 50% (No condensation, Maximum wet bulb temperature: 80.6°F/27°C) 
(When linerless media is used.)

Storage temperature -4°F to 140°F (-20°C to 60°C)
Storage humidity 10% to 90% (No condensation, Maximum wet bulb temperature: 113°F/ 45°C)
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*Using Brother's print test data (7% coverage, 4 in. × 1.14 in. (102 × 29 mm)) at 73.4°F (23°C) when 
performing continuous printing using a USB connection with a new, fully-charged battery.

Power supply

Battery Rechargeable Li-ion battery: 7.2 V

Adapter (optional) AC adapter (15 V)

Car adapter (optional) Cigarette lighter car adapter (12 V (DC))

Maximum number of labels 10,000 labels *

Charging time 4 hours (when charging at 73.4°F (23°C) with the printer turned off, and using a 
new battery)

Media specification

Media type Receipt, Gap/Black mark Label, Tag, Linerless (Optional)

Media width 1.77 in. to 4.49 in. (45 mm to 114 mm)

Thickness Receipt: 2.3 mil to 3.5 mil (0.058 mm to 0.090 mm)

Tag: 3.5 mil to 5.3 mil (0.090 mm to 0.135 mm)

Label: 3.2 mil to 6.7 mil (0.080 mm to 0.170 mm)

Roll outside diameter (max) 2.28 in. (58 mm)

Core diameter (min) Receipt: 0.5 in. (12.7 mm)

Label: 1 in. (25.4 mm)

Media sensor Transmissive, Reflective

Compatible operating systems

See support.brother.com for a complete and updated list of software.

Items

https://support.brother.com
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Parts Description 12

 

1 Charge indicator

2 Battery charging terminals

3 Battery compartment

4 Locking expansion slot

5 DC connector OUT

6 DC connector IN

7 Locking expansion hook

8 DC cord

Specifications 12

Charge time: Approximately 4 hours*

Charge temperature: 32°F to 104°F/0°C to 40°C (recommendable: 41°F to 95°F/5°C to 35°C)

Operating humidity: 10% to 90% (No condensation)

* Varies depending on operating environment and the condition of the battery.

Battery Charger (Optional:PA-BC-003) 12

2 31

4

7

5 65 8
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How to Charge Batteries 12

The AC adapter (PA-AD-600A), which is sold separately, is required for charging.

To charge the rechargeable Li-ion battery, use the charger together with the AC adapter (PA-AD-600A).

The charger (PA-BC-003) cannot recharge the battery alone.

a Connect the AC adapter to the charger’s DC connector IN, and then connect the AC power cord to the 
AC adapter.
 

Note
Insert the AC adapter through the opening in the battery charger as shown in the illustration. Install the AC 
adapter so the battery charger does not press on it.

 

b Connect the AC power cord to a nearby AC power outlet.

c Align the charging terminals of the charger and the battery, and then insert the battery.
The indicator lights in orange when the battery is charging.

d The charge indicator will turn off when charging is complete.
You can then remove the battery.
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Wall Mounting 12

The units can be wall-mounted with two screws per unit. Install the screws vertically with the spacing shown 
below. Ensure the screws are correctly secured with wall anchors or studs. The cavity must face upward (as 
shown) to hold the battery in place.

Use the Insert Nuts 12

Insert nuts are provided on the base of the battery charger. Using these insert nuts, screws may be fastened 
to a board.

When fastening with screws, use the following types of screws.

 M2.6 Pitch 0.45 Screws

 Screws that are 0.14 in. (3.5 mm) to 0.28 in. (7 mm) longer than the thickness of the board

Note
• When attaching to a vertical board, the method of installation is the same as wall mounting (See Wall 

Mounting on page 147).

• Be sure not to pinch the cables between the base of the battery charger and the board.
 

 1: Dia. 0.12 in. - 0.18 in. (3 - 4.5 mm)

2: Dia. 0.33 in. (8.5 mm) or less

3: 0.48 in. (12.2 mm) or more

4: 1.75 in. - 1.87 in. (44.5 - 47.5 mm)

A: Wall material

B: Wall-mount slots

C: Screw

3

1

2

4

A

C
B
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1 1.09 in. (27.7 mm)

2 1.5 in. (38 mm)

3 3.74 in. (95 mm)

21

3

2
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Connect Multiple Battery Chargers 12

Up to four battery chargers can be connected in-line together.

a Insert the locking expansion hook on one Li-ion battery charger into the slot in another Li-ion battery 
charger until it locks into place.
Then, connect the AC adapter to the first battery charger.
 

b Connect one end of the included DC cord to the DC connector OUT of the first battery charger and 
connect the other end of the DC cord to the DC connector IN of the second battery charger.
 

Note
• Connect the AC adapter and DC cord through the opening in the battery charger as shown in the 

illustration.

Install the AC adapter and DC cord so the battery charger does not press on them.

• When connecting battery chargers, it is recommended to use self-tapping screws (M2.6 x 0.24 in. (6 mm)) 
(not included) to firmly secure the battery chargers to one another.
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Disconnect the Battery Chargers 12

a Disconnect the DC cord and AC adapter from the battery chargers.

b Push the tab on the locking expansion hook to release the lock, and then disconnect the battery 
chargers.
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This printer is linerless roll compatible.

Parts Description 13

Linerless Platen Upgrade (Optional:PA-
LPR-001) 13

Linerless Platen Assembly Screws (2 each) 
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Install the Linerless Platen Upgrade 13

a Push the roll cover release lever to open the roll compartment cover.
 

1 Roll cover release lever

b Remove the default platen by removing screws as shown.
 

CAUTION
 

Do not touch the tear bar when removing the default platen.

 

Note
It is recommended a tightening torque be 4.87±0.434 in·lbs (0.55±0.049N·m). 

 

c Install the Linerless Platen Assembly, and fasten it with screws included as shown.
 

1
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Note
• When using the Linerless Platen Upgrade, only upper tear bar is available.

• Use the screws included in the Linerless Platen Upgrade.
 

d Set [Linerless] to [On] in [Advanced] tab the Printer Setting Tool.

Note
• When [Linerless] is set to [On], [Tear Bar] in [Settings] and [Auto Detect] in [Media] in the printer 

cannot be selected.

• When printing, head margin of paper has at least 3/8 in. (9mm) for best performance.

• When using the Linerless Platen, a dust or paper powder is attached to the print head easily. Clean the 
print head regularly (see Linerless Platen Upgrade Maintenance on page 142).

• Use the latest firmware when printing with the Linerless Platen Upgrade.
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Parts Description 14

 

1 Docking station terminals

2 Eject button

3 DC connector IN

4 USB port (Allows to print from a mobile device or a computer by connecting it to the docking station using 
a USB cable.)

Specifications 14

Charge time: About 4 hours*

Charge temperature: 32°F to 95°F/0°C to 35°C (recommendable: 41°F to 95°F/5°C to 35°C)

Operating temperature:

AC adapter: 14°F to 104°F/-10°C to 40°C

Car adapter: 14°F to 122°F/-10°C to 50°C

Operating humidity: 10% to 90% (No condensation)

* Varies depending on operating environment and the condition of the battery.

Note
• The docking station can be used without a battery as a power supply or for printing.

• Do not turn on the printer and the docking station simultaneously.

• Sequential printing and the mass storage mode are not supported when the docking station is used to 
print.

• It is recommended to change the setting of the printer driver to [After one page of data is received] in 
[Other] tab when printing from the docking station.

 

Active Docking Station 
(Optional:PA-CR-002) 14

Active Docking Station Docking Station Terminal 
Attachment

Screws (2 each)

1 2

3
4
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How to Charge Batteries 14

The AC adapter (PA-AD-600A, sold separately) can be used for providing power from an AC power outlet to 
the docking station and charging the battery if installed.

The Active Docking Station (PA-CR-002) cannot recharge the battery alone.

a Connect the AC adapter to the docking station's DC connector IN, and then connect the AC power cord 
to the AC adapter.
 

b Connect the AC power cord to a nearby AC power outlet.

c Remove the docking station terminal cover with a flathead screwdriver. 
Install the docking station terminal attachment to the printer using the docking station terminal 
attachment and screws included with the docking station.
 

Note
Install the docking station terminal attachment. Make sure the notched corner is aligned correctly.

 

d Align the docking station terminals of the docking station and the printer, and then press the printer down 
and onto the docking station until the latches lock it firmly in place.
The printer’s battery indicator lights in orange when charging.



Active Docking Station (Optional:PA-CR-002) 

156

14

 

e The printer’s battery indicator will turn off when charging is complete.

Printer Removal 14

Push the eject button on the back of the docking station and lift the printer and remove it from the docking 
station.
 

1 Eject button

Lock the Eject Button 14

The eject button can be locked by inserting a cotter pin (or similar) through the hole as illustrated below.

It is recommended to use a Low Carbon Steel Extended Prong Retaining Cotter Pin: Length: 1.97 in. (50 mm), 
Pin Diameter: 0.08 in. (2 mm)
 

1

2

1
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1 Diameter: 0.09 in. (2.3 mm)

2 Length: 1.62 in. (41.2 mm)

Note

Contact Brother for the cotter pin.
 

Wall Mounting 14

The docking station can be wall mounted. Affix it to the wall using four screws, as shown in the illustration. 
Make sure you install the docking station in the correct direction so that the printer will not fall.

Use screws with the following dimensions: Length: 0.98 in. (25 mm) or more, Diameter: 0.39 in. (9.8 mm) or 
less
 

 

1 Height: 1.18 in. (30 mm)

2 Width: 1.5 in.(38.1 mm)

221

22

1
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Install the Mounting Arm 14

Optional mounting arms corresponding to the RAM-202U mount are offered for use with the docking station 
which allow a more versatile method of positioning the printer. 

a Secure one of the mounting flanges from the movable arm to the bottom of the docking station, with the 
four (4) #10 - 32 or #10 - 24 screws supplied with the Mounting Arm.

b Secure the other mounting flange on the movable arm to the desired mounting surface. You can use the 
#10 - 24 x 3/4 in. (19.05 mm) screws and associated hardware supplied in the Mounting Arm Kit, or use 
other hardware suitable for the mounting conditions.

 

1 Use a screw to secure to the docking station

2 Docking station

3 Tightening Clamp

4 Use a screw to secure to mounting surface

1

2

3

4
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Overview 15

This chapter explains how to resolve typical problems you may encounter when using the printer. If you have 
any problems with the printer, first make sure you have performed the following tasks correctly:

 Install the battery (see Install the Battery on page 20).

 Connect the AC adapter (see How to Recharge the Battery with the AC Adapter (Optional) on page 23).

 Connect the car adapter (see How to Recharge the Battery with the Car Adapter (Optional) on page 24).

 Remove all protective packaging from the printer.

 Install and select the correct printer driver (see Install the Printer Driver and Software (When Using a 
Computer) on page 33).

 Connect the printer to a Windows computer or mobile device (see Connect the Printer to a Computer or 
Mobile Device on page 34).

 Close the roll compartment cover completely.

 Insert the roll correctly (see Insert the Roll on page 26).

If you still have problems, read the troubleshooting tips in this chapter. If, after reading this chapter, you are 
unable to resolve your problem, visit the Brother support website at support.brother.com.

Printing Problems 15

Troubleshooting 15

Problem Solution

The printer does not print, or there is 
a printing error.

 Is the cable loose (when you are using a USB cable)?

Check that the cable is connected securely.

 Is the roll installed correctly?

If not, remove the roll and reinstall it.

(See Insert the Roll on page 26.)

 Is there enough roll remaining?

If not, install a new roll.

 Is the roll compartment cover open?

Check that the roll compartment cover is closed.

 Has a print error or transmission error occurred?

Turn off the printer and on again. If the problem still occurs, contact Brother 
Customer Service at 1-800-255-0415.

https://support.brother.com


Troubleshooting 

160

15

The printer does not feed paper.  Is there dirt or lint on the roller preventing it from rolling freely? 
Clean the roller. (See Roller Maintenance on page 141.)

 Check that the ejection path of the paper is not blocked.

 Check that the roll is set correctly by removing the roll and installing it again.

(See Insert the Roll on page 26.)

 Ensure that the roll compartment cover is closed correctly.

The printer feeds paper 
continuously.

 Open the roll compartment cover.

 Press the (Power) button or (Back) button to cancel the print job.

 Turn off the printer.

The printer does not pause between 
labels.

 Check that you entered the media information correctly. You can set the 
media information using [Paper Size Setup] in the Printer Setting Tool.

 Check that the sensor is not dirty. If the sensor is dirty, wipe it with a dry 
cotton swab.
 

 

1 Media sensor

 Check that there are no items blocking the sensor.

Problem Solution

1

1
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Printed Image Problems 15

When printing via the USB cable, the 
printer repeatedly pauses and then 
continues printing.

Is the printer set for sequential printing?

If so, set print mode to buffered printing.

For Windows 10 / Windows Server 2016 (RJ-4250WB): 
Open printer properties from [Control Panel] - [Hardware and Sound] - 
[Devices and Printers], right-click the printer you want, and select [Printing 
preferences]. 
Click the [Other] tab and select the option [After one page of data is 
received].

For Windows 7 / Windows 8 / Windows 8.1 / Windows Server 2008 R2 
(RJ-4250WB) / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 
R2 (RJ-4250WB): 
Open printer properties from [Devices and Printers], right-click the printer you 
want, and select [Printing preferences]. Click the [Other] tab and select the 
option [After one page of data is received].

For Windows Server 2008 (RJ-4250WB): 
Open Printer Properties from [Control Panel] - [Hardware and Sound] - 
[Printers], click the printer you want, and select [Select printing preferences]. 
Click the [Other] tab and select the option [After one page of data is 
received].

An error occurs when the roll cannot 
be fed to the beginning of the 
printing.

If a feed error occurs, use the Paper Size Setup of the Printer Setting Tool to 
assign the correct paper settings to the printer or click [Select Media] to 
check whether correct media is set in the printer when RD roll is used.

Problem Solution

Printed paper contains streaks or 
poor quality characters, or paper is 
not fed correctly.

Is the print head or roller dirty?

Although the print head generally remains clean under normal use, lint or dirt 
from the roller may become stuck on the printer head. If this occurs, clean the 
roller (see Roller Maintenance on page 141).

The print quality is poor.  Is there dust or dirt on the print head or roller preventing it from turning 
freely?

Clean the print head or roller (see Print Head Maintenance on page 140 and 
Roller Maintenance on page 141).

 Adjust the printing density. The print density can be specified in the Printer 
Setting Tool.

Problem Solution
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Printer Problems 15

Printed barcodes cannot be read.  Print labels so that barcodes are aligned with the print head as shown 
below.
 

1 Print head

2 Barcode

3 Printing orientation

 Try using another barcode reader.

 Set [Print Speed] to a slower option. The print speed can be specified in the 
Printer Setting Tool. (See Device Settings on page 68.)

 Adjust [Print Density]. The print density can be specified in the Printer 
Setting Tool. (See Device Settings on page 68.)

 This printer is not designed exclusively for creating barcode labels. Always 
check that barcode labels can be read by the barcode reader.

Problem Solution

The LED indicator or the LCD is not 
lit.

 Is the battery inserted correctly?

Check that the battery is inserted correctly. If it is, check that the battery has 
sufficient charge remaining.

 Is the adapter cord connected properly?

Check that the cord is connected correctly.

 If the LED indicator or the LCD still does not light up, contact Brother 
Customer Service at 1-800-255-0415.

A data transmission error appears on 
your computer.

 Is the correct port selected?

Check that the correct port is selected.

 Is the printer in cooling mode?

The message [Cooling] is displayed on the LCD. 

Wait until the message disappears and then try printing again.

 Are there any unfinished print jobs?

If you try to print while other users are printing large amounts of data, the 
printer is unable to accept your print job until the current print jobs are 
completed. If this occurs, send the print job again after the other jobs are 
completed.

Problem Solution

1

2

3
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I want to reset the printer/delete the 
data transferred from the computer.

To reset the printer, perform the following procedure:

1 Press the (Power) button to turn off the printer.

2 Press and hold the (Feed) / OK button and the (Power) button for 
about five seconds.

3 While pressing the (Power) button, press the (Feed) / OK button six 
times.

4 Release the (Power) button.

All the transferred data from the computer will be deleted and the printer 
settings will be reset to the factory settings.

I want to cancel the current print job. Make sure that the printer is On, and then press the (Power) button or 
(Back) button.

Print head, motor, or battery is too 
hot.

The thermal head, motor, or battery is too hot.

 Head: 
If the thermal head becomes too hot, it may produce imaging on the paper 
in areas not intended to be printed. This condition is normal when printing 
documents with a lot of “black” content.

The printer will stop and resume printing after the print head has cooled 
down.

To avoid or delay this condition, print using a lighter density setting, reduce 
the amount of black space being printed (for example, remove background 
shading and colors in graphs and presentation documents), and make sure 
that the printer has adequate ventilation and is not located in an enclosed 
space.

 Motor or battery: 
Do not use the printer continuously. If the printer is used continuously, the 
motor or battery will become too hot. In this case, the printer will stop and 
resume printing after the motor or battery has cooled down.

Note
This condition may occur more often when the printer is used at high altitude 
(more than about 10,000 feet) due to a lower air density available to cool the 
printer.

 

Transferring the program failed. The system will recover if the program is transferred again. To resolve the 
issue, contact your Brother dealer or Brother customer service for assistance.

Problem Solution
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Network Setup Problems 15

Problem Solution

You are using security software  Confirm your settings in the installer dialog box.

 Allow access when the security software alert message appears during the 
printer installation.

Your security settings 
(SSID/Network Key) are 
incorrect

Make sure the network security settings are correct:

 See the instructions supplied with your Wi-Fi access point/router for information 
on how to find the security settings.

 The default SSID (Network Name) may be your Wi-Fi access point/router's 
manufacturer name or model number.

 Contact the manufacturer of your Wi-Fi access point/router or ask your Internet 
provider or network administrator.

The printer cannot connect to the 
mobile device using Wi-Fi or 
Bluetooth.

 Move the printer within about 3.3 feet (one meter) of the mobile device when 
you configure the Wi-Fi network settings.

 Move the printer to an obstruction-free area.

 If a wireless computer, Bluetooth-equipped device, microwave oven, digital 
cordless phone, or other device is near the printer or the Wi-Fi access 
point/router, move the device away from the printer or Wi-Fi access point/router.

The printer cannot print using Wi-
Fi or Bluetooth.

You are using MAC Address 
filtering

 You can confirm the MAC address by printing out the printer information. Press 

and hold the (Feed) / OK button to print the printer information.

 Set the Wi-Fi access point/router so that the MAC address of the printer is 
allowed for connections. For more information, see the instructions supplied 
with your Wi-Fi access point/router.

Your Wi-Fi access point/router is 
in stealth mode (not broadcasting 
the SSID)

 Enter the correct SSID name during the installation or when using 
[Communication Settings] in the Printer Setting Tool.

 Check the SSID name in the instructions supplied with your Wi-Fi access 
point/router and set up your wireless network again.

The printer is not connected 
correctly to the network.

Check the WLAN icon on the LCD.

, , : The printer is already connected some wireless network. Check 
the wireless network information and confirm to connect your Wi-
Fi access point/router correctly.

: The printer is searching for the network. Make sure the Wi-Fi 
access point/router is available and wait a while. Then the printer 
is still not connected, set up the printer's Wi-Fi connection again.

No icon : The wireless network feature on your printer is off. Make sure that  
the printer is in the mode you want to connect to.

I have checked and tried all of the 
above, but still cannot complete 
the wireless configuration.

Turn off the printer and on again. Then try and configure the Wi-Fi settings again.
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Cannot Print over the Network 
Printer Is Not Found on the Network Even after Successful Installation 15

Security Software Problems 15

Problem Solution

You are using security software See Security Software Problems on page 165.

The printer is not assigned with 
an available IP address

 Confirm the IP address and the Subnet Mask. 
Verify that both the IP addresses and Subnet Masks of your computer and the 
printer are correct and located on the same network. 
For more information on how to verify the IP address and the Subnet Mask, 
contact your network administrator.

 Confirm your IP address, Subnet Mask and other network settings in 
[Communication Settings] in the Printer Setting Tool. 
See Change the Printer Settings on page 46.

Your previous printing job failed  If the failed printing job is still in your computer's print queue, delete it.

Example (Windows 7): Click [Start], [Devices and Printers] and select the 
printer from [Printers and Faxes]. Double-click the printer's icon, and then 
select [Cancel All Documents] in the [Printer] menu.

The printer is not connected 
correctly to the network

Check the WLAN icon on the LCD.

, , : The printer is already connected some wireless network. Check 
the wireless network information and confirm to connect your Wi-
Fi access point/router correctly.

: The printer is searching for the network. Make sure the Wi-Fi 
access point/router is available and wait a while. Then the printer 
is still not connected, set up the printer's Wi-Fi connection again.

No icon : The wireless network feature on your printer is off. Make sure that  
the printer is in the mode you want to connect to.

I have checked and tried all the 
above, but my printer does not 
print.

Uninstall the printer driver and the software, and then reinstall them.

Problem Solution

You did not choose to allow 
access when the security alert 
dialog box appeared during 
either the standard installation, 
BRAdmin Light installation, or 
when printing

If you did not choose to accept the security alert dialog box, the firewall function of 
your security software may be rejecting access. Some security software might 
block access without showing a security alert dialog box. To allow access, see the 
instructions of your security software or contact the manufacturer.

Incorrect port numbers are being 
used for the Brother network 
features

The following port numbers are used for Brother network features:

 BRAdmin Light i Port number 161 / Protocol UDP

For more information about how to open the port, see the instructions for the 
security software or contact the manufacturer.
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Check the Operation of Network Devices 15

Problems with Battery Charger (Optional) 15

If you experience any problems that you cannot resolve, please contact the reseller where the product was 
purchased.

Problem Solution

The printer and Wi-Fi access 
point/router are not turned on

Make sure you have confirmed all instructions in Overview on page 159.

I do not know my printer's 
network settings, such as the IP 
address

Check [Communication Settings] in the Printer Setting Tool.

See Change the Printer Settings on page 46.

The printer is not connected 
correctly to the network.

Check the WLAN icon on the LCD.

, , : The printer is already connected some wireless network. Check 
the wireless network information and confirm to connect your Wi-
Fi access point/router correctly.

: The printer is searching for the network. Make sure the Wi-Fi 
access point/router is available and wait a while. Then the printer 
is still not connected, set up the printer's Wi-Fi connection again.

No icon : The wireless network feature on your printer is off. Make sure that  
the printer is in the mode you want to connect to.

Problem Solution

The charge indicator turned off, but the battery 
has not fully charged.

Charging stopped because the battery became too hot or too cold. 
Please wait and try charging the battery later.

The charge indicator flashes orange. An error occurred during charging.

 Wipe the charging terminals of the charger and the battery with 
a dry cloth.

 Replace the battery with a new one.

 Wait and try charging the battery later.
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Problems with Active Docking Station (Optional) 15

If you experience any problems that you cannot resolve, please contact the reseller where the product was 
purchased.

Problems with Linerless Platen Kit (Optional) 15

Problem Solution

The charge indicator turned off, but the battery 
has not fully charged.

Charging stopped because the battery became too hot or too cold. 
Please wait and try charging the battery later.

The charge indicator flashes red. An error occurred during charging.

 Wipe the docking station terminals of the docking station and 
the battery with a dry cloth.

 Replace the battery with a new one.

 Wait and try charging the battery later.

The printer does not turn on when placed it on the 
docking station.

 Set the printer on the docking station correctly.

 Check the AC adapter is correctly connected.

 Reconnect the AC adapter. 

The printer does not print via a USB cable.  Set the printer on the docking station correctly.

 Connect a USB cable correctly.

 If USB cables are connected to the printer and the docking 
station simultaneously, disconnect the one connected to the 
printer, turn off the printer and turn on again.

 (RJ-4250WB only) Select the correct driver in the Devices and 
Printers. If the docking station is connected, your operating 
system will also display a copy of the printer driver icon (for 
example: Brother RJ-4250WB (Copy 1)) in the Devices and 
Printers. Make sure it is not selected.

Problem Solution

The print quality is poor.  Install the Linerless Platen Upgrade correctly.

 Clean the printing head.

The printer does not feed paper.  Install the Linerless Platen Upgrade correctly.

 Set the roll correctly.

 Check if a label or adhesive is attached the inside of the cover. 
If so, clean the inside of the cover.
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Error Messages from the Printer 15

The media becomes jammed. Check the following points. If the printer still remains jammed, 
replace the Linerless Platen Upgrade.

 Install the Linerless Platen Upgrade correctly.

 Wipe away an adhesive if it is attached on the ejection path of 
the paper.

 Clean the inner cavity and the roll holders.

 Adhesive strength of the roll might be too strong.

Error Message Cause/Remedy

No Template  Selected  There is no template with the specified number. 
Specify the correct number.

 When printing a template, an error is indicated if the specified template does 
not exist.

 The template was not transferred. Register the template with the specified 
number to the printer.

Invalid Database Record  An error will occur when printing a template which specifies an incorrect key 
code, or a non-existent key code in a linked database.

Media Error! Check Loading  Is the correct roll installed?

Check that the correct media, for example, type (die-cut label or continuous 
length tape) and die-cut label size, is installed.

 Is the roll installed correctly?

If not, remove the roll, and then reinstall it. For details, see Insert the Roll 
on page 26.

 Is enough of the roll remaining?

If not, install a new roll.

Cover Open Close Cover Is the roll compartment cover open? 
Check that the roll compartment cover is closed.

Communication Error  Transfer of the data failed. When sending a template as a .blf file, an error 
is indicated if the model name in the file is different.

 Has the wireless LAN or Bluetooth connection been interrupted?

Turn off the printer and on again.

WPS did not connect Try to 
connect again

The Wi-Fi access point/router could not be found.

Mass Storage Operation 
Error!

Is the printer in mass storage mode?

 The printer's file system may be corrupted, or a file's name or contents were 
changed while the file was being transferred or processed. Turn off the 
printer and then on again.

 Do not access files on the printer during mass storage processing to avoid 
further problems.

Problem Solution
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Recharge Battery! Does the rechargeable battery have a low charge?

Use the AC adapter and AC power cord to connect the printer to an AC power 
outlet, or use the car adapter to connect the printer to a DC power outlet to 
charge the battery.

System Error!

XX

If the error message is displayed, contact Brother customer service.

Memory Full!  Print jobs exceeding 118.1 in. (3 m) and incompatible files cannot be 
printed.

 Make sure the data you transfer does not exceed the capacity of the user 
storage area.

ChargingError Cannot Charge Is battery charging incomplete despite continuous charging?

Confirm that the battery is correctly installed. If charging still fails to complete, 
the battery may be deteriorated. Replace the battery with a new one.

High Temp! Is the printer temperature too high?

When Linerless rolls setting is active and the printer overheats, the error 
message is displayed. Wait until the printer cools down and resume operating 
the printer.

Error Message Cause/Remedy
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